# Contents

**Chapter 1 • Introduction** ................................. 1
  Overview of SAS Solutions Services .......................... 1
  What's Changed in SAS Solutions Services 5.1 .............. 2
  Required Skills ........................................... 3
  Documentation Conventions .................................. 3
  Additional Documentation .................................... 3

**Chapter 2 • Post-Configuration Steps** .................. 5
  Overview of the Post-Configuration Tasks .................... 6
  Set E-Mail Addresses for Administrators ..................... 6
  Modifications for SAS Human Capital Management .............. 7
  Modifications for SAS Strategy Management .................. 11
  Modifications for SAS Financial Management ................. 12
  (Optional) Configure Quick Help Display ...................... 13
  Secure Your Installation ................................... 14
  Configure a SAS Data Integration Studio User ................ 16
  (SAS Financial Management; Optional) Verify Using Sample Data 17
  (SAS Human Capital Management; Optional) Verify Using Sample Data 22
  (SAS Strategy Management; Optional) Verify Using a Sample Project 26
  Create the Site's Users and Groups ......................... 26
  Load Production Data ...................................... 27
  Install Client Applications ................................ 27
  Check SAS Notes for Additional Information .................. 27

**Chapter 3 • Assigning Groups and Roles** ............... 29
  Overview of Users, Groups, and Roles ....................... 29
  SAS Solutions Services Users, Groups, and Roles ............ 30
  SAS Strategy Management Groups and Roles ................... 32
  SAS Financial Management Groups and Roles .................. 35
  SAS Human Capital Management Groups and Roles .......... 40
  Registering Users ....................................... 44

**Chapter 4 • Portal and Content Administration** ........ 47
  Portal Administration ..................................... 47
  Administering Content ..................................... 49

**Chapter 5 • Administering the Middle Tier** ............. 51
  Managed Server Administration ................................ 51
  Performance Improvement in SAS Financial Management ....... 53

**Chapter 6 • Viewing and Configuring the Log Files** ...... 61
  Log File Locations and Configuration Files ................. 61
  Dynamically Configuring Logging Levels ..................... 62
  Configure a Log File for the SAS Financial Management Reports 63
  Log Files for Client Applications .......................... 63
  Additional Log Files ....................................... 64

**Chapter 7 • Administering MySQL Server** ............... 65
  MySQL Overview .......................................... 65
  MySQL Installation and Configuration (Windows) .............. 65
**Chapter 8 • Installing the Client Applications**

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>About the Client Applications</td>
<td>67</td>
</tr>
<tr>
<td>Selecting a SAS Environment</td>
<td>68</td>
</tr>
<tr>
<td>SAS Financial Management Studio and SAS Solutions Services</td>
<td></td>
</tr>
<tr>
<td>Dimension Editor</td>
<td>69</td>
</tr>
<tr>
<td>The Add-In Clients for Microsoft Office</td>
<td>70</td>
</tr>
<tr>
<td>Defining Multiple SAS Environments</td>
<td>74</td>
</tr>
<tr>
<td>Defining Multiple SAS Solutions Environments</td>
<td>75</td>
</tr>
<tr>
<td>Uninstalling the Client Applications</td>
<td>77</td>
</tr>
</tbody>
</table>

**Appendix 1 • Default Port Usage**

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Port Usage</td>
<td>79</td>
</tr>
</tbody>
</table>

**Index**

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Index</td>
<td>81</td>
</tr>
</tbody>
</table>
Chapter 1
Introduction

Overview of SAS Solutions Services

SAS Solutions Services is a set of services that provide common functionality and a framework for specific solutions. SAS Solutions Services builds on the SAS Intelligence Platform and includes the following areas of functionality:

- Document management allows users to create, organize, and secure documents of disparate types based on their own folder structures.
  
  Document Manager, a Web application, supports management and viewing of the documents.

  A My Favorites portlet provides shortcuts to the folders or the documents themselves, and some documents can also be viewed within a portlet.

- Key performance indicator (KPI) management enables the user to create and manage KPIs for various levels within an organization. Based on security authorization, a user can create, manage, and modify KPI projects.

  A Web application, KPI Viewer, enables the user to open KPI projects. The Performance Dashboard portlet enables the user to put KPIs on a dashboard.

- Dimension Management provides the ability to create, manage, and add values to dimensions and hierarchies. A Java client application, SAS Solutions Services Dimension Editor, allows the user to interactively create and modify the dimensions.

- Microsoft Office integration provides the ability to integrate documents from SAS Solutions Services within the Microsoft Office suite of applications.

- A role-based user interface provides a means of associating user capabilities with the roles a user has (for example, administrator or analyst).

These SAS Performance Management solutions use SAS Solutions Services 5.1:

- SAS Financial Management 5.1
What's Changed in SAS Solutions Services 5.1

SAS Solutions Services 5.1 includes the following changes:

- Some features are now a part of the SAS Intelligence Platform or the Web Infrastructure Platform. As such, they are still available to users when they are using SAS Solutions Services and the solutions. They include:
  - the Solutions Web Administration application (with some changes in functionality)
  - the alerts service and the Alerts portlet
  - the directives service
  - the Configuration Manager plug-in of SAS Management Console
  - the Comment Manager application

- Users now log on via a common Logon Manager, which is part of the Web Infrastructure Platform.

- Document Manager has the following changes:
  - SAS Human Capital Management objects (such as a geographic analysis or an organization analysis) are not supported in Document Manager (or in a My Favorites portlet). For these objects, use the SAS Human Capital Management workspace.
    The My Favorites portlet does support a link to the Home page of SAS Human Capital Management.
  - SAS Web Report Studio and SAS Web OLAP Viewer are not supported in Document Manager or a My Favorites portlet. For links to those applications, SAS reports, or data explorations, use a Collection portlet instead.
  - The Search tab is removed. Use the portal Search button instead.
  - To run a stored process, users now click the stored process name. The Refresh menu option is not supported, and stored process reports (STO objects) are not supported.
  - Deleting a document no longer moves it to the Trashcan. Instead, it is completely deleted.

- There are changes to the user identities, roles, and groups that are used in SAS Solutions Services as well as the solutions. For more information, see Chapter 3, “Assigning Groups and Roles,” on page 29.

- The Measure Manager application and the Backup, Restoration, and Migration (BRU) utility are not included with SAS Solutions Services 5.1.

- Quick Help must be enabled or disabled in SAS Management Console for a site or for one or more software components. It cannot be configured at the end-user level.

For information about a particular solution, see the documentation for that solution.
Required Skills

To administer the solutions software, you must be familiar with the operating system on which it is installed. For example, you must know how to create folders, run scripts (.bat files or .sh files), and update environment variables. On Microsoft Windows, you must be an administrator of the machine.

Documentation Conventions

This book uses the following documentation conventions to identify paths in the solutions configuration:

<table>
<thead>
<tr>
<th>Path</th>
<th>Refers to</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>!sasroot</td>
<td>Path to the SAS root directory</td>
<td>C:\Program Files\SAS \SASFoundation\9.2</td>
</tr>
<tr>
<td>SAS-config-dir</td>
<td>Path to the SAS configuration directory</td>
<td>C:\SAS\Config</td>
</tr>
<tr>
<td>MySQL-install-dir</td>
<td>Path to the MySQL installation directory</td>
<td>C:\mysql</td>
</tr>
</tbody>
</table>

Note:

- The name of the configuration directory and the level number might be different at your site.
- If your configuration is the result of a migration from the previous release of SAS Solutions Services, the SASApp directory might be called SASMain instead (for example, C:\SAS\Config\Lev1\SASMain rather than C:\SAS \Config\Lev1\SASApp). Please make the appropriate substitutions as you read this book.

Additional Documentation

For additional information, see the appropriate versions of the following books:

- SAS Solutions Services: Data Administration Guide
- SAS Solutions Services: Data Model Reference
- SAS Solutions Services: Customization Guide
- SAS Performance Management Solutions: Migration Guide
Chapter 1 • Introduction

- The administrator's guide for SAS Human Capital Management
- The SAS Intelligence Platform administration guides, which are available at support.sas.com/92administration
# Chapter 2
Post-Configuration Steps

| Overview of the Post-Configuration Tasks | 6 |
| Set E-Mail Addresses for Administrators | 6 |
| Modifications for SAS Human Capital Management | 7 |
| Add Permissions for the OLAP Schema | 7 |
| (Optional) Modify SAS Web Report Studio Properties | 7 |
| Modify Metric Definition File for SAS BI Dashboard | 8 |
| Modify the Diagnostics Configuration File | 8 |
| Additional Localizations | 10 |
| Modifications for SAS Strategy Management | 11 |
| Localization: Modify the %SPMEXPSC Macro | 11 |
| (Optional) Modify Metric Definition File for SAS BI Dashboard | 11 |
| Modifications for SAS Financial Management | 12 |
| (Optional) Change the CTA Behavior for Intercompany Transactions | 12 |
| (Optional) Configure Quick Help Display | 13 |
| Secure Your Installation | 14 |
| Configure Security Settings for Folders and Files | 14 |
| Secure Access to MySQL | 15 |
| Configure a SAS Data Integration Studio User | 16 |
| (SAS Financial Management; Optional) Verify Using Sample Data | 17 |
| Overview | 17 |
| Download Scripts and Batch Programs | 17 |
| Load Sample Data | 18 |
| Verify the Installation | 19 |
| Reset the DDS, stageDDS, and SASSDM Databases | 21 |
| (SAS Human Capital Management; Optional) Verify Using Sample Data | 22 |
| Overview | 22 |
| Download the Batch Program | 22 |
| Load the Sample Data | 23 |
| Verify the Installation | 24 |
| Reset the DDS, stageDDS, and HCM Databases | 25 |
| (SAS Strategy Management; Optional) Verify Using a Sample Project | 26 |
| Create the Site's Users and Groups | 26 |
| Load Production Data | 27 |
| Install Client Applications | 27 |
Overview of the Post-Configuration Tasks

This chapter describes the post-configuration tasks that need to be performed for SAS Solutions Services, SAS Financial Management, SAS Strategy Management, and SAS Human Capital Management. It also describes how to load sample data that can be used to verify the installation and demonstrate the software.

For more information about the solutions, see the online Help and user's and administrator's guides, as well as the SAS Solutions Services: Data Administration Guide (available at support.sas.com/documentation/solutions/admin/index.html).

For more information about the SAS Intelligence Platform, see the following references:

• SAS Intelligence Platform: Installation and Configuration Guide
• SAS Intelligence Platform: System Administration Guide
• SAS Intelligence Platform: Security Administration Guide
• SAS Intelligence Platform: Application Server Administration Guide
• SAS Intelligence Platform: Security Administration Guide
• SAS Intelligence Platform: Web Application Administration Guide

These books are available at http://www.support.sas.com/92administration.

Set E-Mail Addresses for Administrators

After installation and configuration, set the e-mail addresses for administrative and error messages, if you have not already done so. This task is performed in the Configuration Manager plug-in of the SAS Management Console.

1. Log on to SAS Management Console as an administrator.
2. On the Plug-ins tab, navigate to Application Management ⇒ Configuration Manager.
3. Right-click SAS Application Infrastructure and open its properties.
4. Click the Settings tab.
5. In the left pane, select Notifications ⇒ Administration and Error Messages.
6. In the Sender of messages box, type the e-mail address that will go in the From field of these messages.
   If you do not want users to reply to such messages, you might want to create a send-only account on your mail server that is valid. Users can then add the account to their safe senders list but cannot reply.
7. In the Recipient of administrative messages box, enter one or more e-mail addresses of users to receive these messages.
8. Click OK.
For more information about related properties, see “Setting Global Properties for SAS Applications Using SAS Application Infrastructure Properties” in the SAS Intelligence Platform: Web Application Administration Guide.

**Modifications for SAS Human Capital Management**

**Add Permissions for the OLAP Schema**

If members of the HCM Solution Users group do not have permissions for the OLAP schema, add those permissions as follows:

1. Log on to SAS Management Console as an administrative user.
2. On the **Folders** tab, navigate to Shared Data ⇒ SASApp - OLAP Schema.
3. In the right pane, right-click the OLAP schema name and select **Properties**.
4. On the **Authorization** tab, grant ReadMetadata permission to the HCM Solution Users group. Grant ReadMetadata and WriteMetadata permission to HCM data administrators.
5. Click **OK**.

For more information about the metadata permissions that are required for using cubes, see the “Authorization Model” chapter of the SAS Intelligence Platform: Security Administration Guide. For information about operating-system permissions for cubes, see Table 2.1 on page 14.

**Optional** Modify SAS Web Report Studio Properties

SAS Human Capital Management includes a set of reports for viewing in SAS Web Report Studio. These reports are automatically loaded during the installation.

To modify properties of SAS Web Report Studio, use the Configuration Manager of SAS Management Console. For example, one property, MAX_TUPLE_COUNT, limits the amount of data that can be retrieved from a query. (A tuple refers to a cross-section of member data in a cube.) If a report query fails with an error saying that the data set is too large, you might need to increase the MAX_TUPLE_COUNT value, as follows:

1. Open SAS Management Console as an administrative user.
2. On the **Plug-ins** tab, navigate to Application Management ⇒ Configuration Manager.
3. Right-click Web Report Studio 4.2 and select **Properties**.
4. Click the **Advanced** tab.
5. Click **Add** to add a new property.
6. In the **Property Name** field, enter this value:
   .vmwide.com.sas.iquery.dataservices.ProcSummaryROLAPBuilder.MAX_TUPLE_COUNT
7. In the **Property Value** field, enter a value. The default is 2500.
8. Click **OK** to save the new definition, and then click **OK** again to close the properties window.
9. Restart the managed servers.
For more information about modifying properties for SAS Web Report Studio, see the “Configuring SAS Web Report Studio” chapter of the SAS Intelligence Platform: Web Application Administration Guide.

Modify Metric Definition File for SAS BI Dashboard

If you installed SAS Human Capital Management, you need to modify the HCM metric definition file for SAS BI Dashboard. Follow these steps:

1. On the middle tier of your installation, change directory to <SAS-config-dir>\Lev1\AppData\SASBIDashboard4.2\dataSourceDefs.
2. Open the hcm_metric.dsx file for editing.
3. Find this line:
   `<WSUrl>@midtier.hcmmidtier.url@@webapp.hcmmidtier.contextroot@/services/HcmWS</WSUrl>`
4. Replace `@midtier.hcmmidtier.url@@webapp.hcmmidtier.contextroot@` with the following value:
   `http://server-name:port/SASHumanCapitalManagement`, where `server-name` is the name of the middle-tier server and `port` is the port number to which the SAS Human Capital Management application is deployed. (For a list of default port numbers, see “About the Managed Servers” on page 51.)
5. Save the file and restart the managed server.

**Note:** By default, SAS BI Dashboard checks for updated information maps only once. You might want it to make regular checks, particularly if you refresh or rebuild information maps on a regular basis. To change this behavior, you must edit the Advanced properties of SAS BI Dashboard in the Configuration Manager of SAS Management Console. Set the value of the bid.syncIndicatorModels property to `true`. For more information about using the Configuration Manager, see the SAS Intelligence Platform: Web Application Administration Guide.

Modify the Diagnostics Configuration File

**If Necessary) Modify Paths and Component Names**

Before using the HCM Diagnostics utility, you might need to modify the paths on the data tier, if you did not use the default path in your installation. To make this change:

1. Open the DiagnosisConfig.xml file for editing.
   - On Windows, this file is located in the <SAS-config-dir>\Lev1\Applications\SASHumanCapitalManagement5.1\Diagnostics directory on the middle tier.
2. Find the `<FileSystem><DataTier><Folders>` section of the XML file.
3. Within that section, modify the paths to any folders or files on the data tier.
   - **Note:** Use local paths (such as `C:\` or `D:\`) rather than UNC paths.
4. Save your changes.
If the site changes names for components such as logical servers, the EAR file or WAR filename, or table names, you must also modify those names in the DiagnosisConfig.xml file.

*Note:* The diagnostics utility currently supports single-tier and two-tier configurations. A two-tier configuration is assumed to be composed of a data tier and a middle tier, with the diagnostics being deployed on the middle tier.

**Localizations**

*Note:* The user interface of the diagnostics utility currently supports only the English language. However, you can localize the test names by editing the DiagnosisConfig.xml file.

If you installed SAS Human Capital Management in a language other than English, you must modify the following server names in the diagnostics configuration file. Follow these steps:

1. Log on to SAS Management Console as an administrator.
2. On the **Plug-ins** tab, navigate to **Environment Management ⇒ Server Manager**.
3. Right-click **SAS Content Manager** and select **Properties**.
4. On the **General** tab of the Properties dialog box, copy the name of the SAS Content Manager and save it for later use.
5. Navigate to **Environment Management ⇒ Server Manager ⇒ SASApp**.
6. Copy and temporarily store the names of the following servers:
   - **SASApp - Logical OLAP Server**
   - **SASApp - Logical Workspace Server**
   - **SASApp - Logical Stored Process Server**
7. Open the DiagnosisConfig.xml file for editing.
   
   On Windows, this file is located in the `SAS-config-dir\Lev1\Applications\SASHumanCapitalManagement5.1\Diagnostics` directory on the middle tier.
8. Find the following line:
   ```xml
   <ContentServer name="SAS Content Server"/>
   ```
9. In that line, substitute the name of your site's SAS Content Server for **SAS Content Server**.
10. Find the following section:
    ```xml
        <LogicalServers>
        <WorkspaceServers>
            <Server name="SASApp - Logical Workspace Server"/>
        </WorkspaceServers>
        <StoredProcessServers>
            <Server name="SASApp - Logical Stored Process Server"/>
        </StoredProcessServers>
        <OLAPServers>
            <Server name="SASApp - Logical OLAP Server"/>
        </OLAPServers>
    </LogicalServers>
    ```
11. Substitute the names of the corresponding servers that you copied from SAS Management Console.
12. Save the file.

**Add the JUnit JAR File**

Before running the diagnostics, you must copy the JUnit 4.5 JAR file to the `SAS-config-dir\Lev1\Applications\SASHumanCapitalManagement5.1\Diagnostics\lib` directory on the middle tier.

The JUnit JAR file supports the testing framework. You should have downloaded this JAR file during the installation process. For details, see the installation guide.

**Additional Localizations**

**Set the Correct Date Format**

If you installed the HCM MySQL database using a stored date format other than the default (`yyyy-MM-dd`), you must modify the HCM configuration file, so that conversions from stored date formats to displayed date formats are correct. Follow these steps:

1. Open the `HCMConfig.xml` file for editing. This file is located in the `SAS-config-dir\Lev1\AppData\SASHumanCapitalManagement5.1` directory.

2. Find this property:

   `<Property Id="date_format_database" Name="Date format of database" Value="yyyy-MM-dd" ReadOnly="false"/>

3. Replace the value with the correct date format.

4. Save the file.

**Set the Default Font for PDF Files**

If your site supports DBCS languages, set the font that is used when a user saves data to a PDF file from the Employee Browser, a geographic analysis, an organization analysis, or the general search results.

You can set this value on the `Configuration` tab of the Administration application in SAS Human Capital Management. For details, see the *SAS Human Capital Management: Administrator's Guide* or the online Help for the `Configuration` tab.

**Support User Locale Preferences**

Follow these guidelines to support user locale preferences:

- When users are logged on to SAS Human Capital Management, they can select a locale by clicking Preferences. For the best user experience, advise your users to select a locale to match the locale that you selected when you installed the SAS software. Otherwise, some messages might not be displayed in the localized text. Users should specifically select a locale, rather than selecting Browser Default.

  *Note:* In terms of data display, the user locale preference affects only stored process reports.

- In the MySQL HCM database, check the `SAS_DEFAULT_PROPERTIES` table to make sure that the value of PropFilePath is correct. This value should point to the `!sasroot\hrds\sasmisc` directory on the data tier. It tells the `%SETLOCS` macro where to find the `hcmtitles.properties` and `hcmlabels.properties` files. These properties files are used for localization (for example, for titles in stored process output and for some of the labels in an OLAP cube).
In deciding which properties file to use, the %SETLOCS macro first looks for an exact match to the user preference, including both the language-code and the country-code (for example, hcmtitles_ja_jp.properties). If an exact match cannot be found, the %SETLOCS macro looks for a match with the same language-code (for example, hcmtitles_ja.properties). If no match exists, the properties files for the installed HCM locale are used. For more information about these properties files, see “Managing the Data Sources” in the SAS Human Capital Management: Administrator's Guide.

Modifications for SAS Strategy Management

Localization: Modify the %SPMEXPSC Macro

If you installed SAS Strategy Management in a language other than English, you must modify the SAS autocall macro %SPMEXPSC as follows:

1. Log on to SAS Management Console as an administrator.
2. On the Plug-ins tab, navigate to Environment Management ⇒ Server Manager.
3. Right-click SAS Content Server and select Properties.
4. On the General tab of the Properties dialog box, copy the name of the SAS Content Server and store it for later use.
5. Open the spmexpsc.sas file for editing.
   On Windows, this file is located in the !sasroot\scorecard\sasmacro directory on the data tier.
   
   Note: We recommend that you first make a backup copy of this file.
6. Find the following line:
   `ss = "omsobj:TCPIPConnection?TCPIPConnection[Source/ServerComponent[@Name='SAS Content Server' and @ClassIdentifier='DAC0D7F0-10DA-11D6-8816-AA0004006D06']];";`
7. In that line, substitute the name of your site's SAS Content Server for SAS Content Server.
8. Make the same change to the following line:
   `ss = "omsobj:Directory?Directory[DeployedComponents/ServerComponent[@Name='SAS Content Server' and @ClassIdentifier='DAC0D7F0-10DA-11D6-8816-AA0004006D06']];";`
9. Save the file.

(Optional) Modify Metric Definition File for SAS BI Dashboard

By default, a data provider is defined to make SAS Strategy Management data available to SAS BI Dashboard. There are occasions when you might want to make this data available across installations (that is, across different SAS environments, with their own metadata server, managed servers, and remote services). For example, if you installed SAS Strategy Management in installation A, and you want to also provide access to this data to SAS BI Dashboard in installation B, then you need to add a property that allows access from installation B. On the data tier for installation A, follow these steps:
1. Log on to SAS Management Console as the SAS administrator.
2. On the Plug-ins tab, navigate to Application Management ⇒ Configuration Manager ⇒ Strategy Mgmt 5.1.
3. Right-click and select Properties.
4. Select the Advanced tab.
5. Click Add.
6. In the Define New Property dialog box, enter the property name and property values:
   - Property Name: SPMProvider.Midtier.trusted.URLs
   - Property Value: server addresses
     The server addresses can be one or more comma-delimited addresses of servers where the SAS BI Dashboard is deployed. These values can be an IP address or a server:port address. (By default, the SAS BI Dashboard is deployed to SASServer1, so a typical port number would be 7001.) Do not include the http or https protocols in the addresses.
7. Click OK to save the property.
8. Click OK again to exit the Strategy Mgmt 5.1 Properties dialog box.
9. The new property takes effect the next time you restart the managed servers.

---

**Modifications for SAS Financial Management**

*(Optional) Change the CTA Behavior for Intercompany Transactions*

SAS Financial Management supports two methods of accounting for Cumulative Translation Adjustments (CTAs) as they relate to intercompany transactions:

- **Elimination of CTA amounts related to intercompany transactions.** This is the default behavior. It assumes that revaluation of intercompany balances as a result of exchange rate fluctuations occurs within a customer’s source accounting system. Any translation adjustments that arise as the result of intercompany transactions are eliminated in the originating organization’s functional currency via Intercompany Eliminations.

- **Persistence of CTA amounts related to intercompany transactions.** This functionality ignores CTA amounts related to intercompany transactions, allowing values to persist without being eliminated. This behavior might be necessary when revaluation of intercompany balances does not occur in a customer’s source accounting system and reporting currency differs from the functional currency of the lowest common parent.

Choose a method based on a customer’s practices for recording and managing intercompany transactions and balances. Selecting the appropriate method results in balanced, consolidated results.

The behavior is determined by a system property, odcs.cta.elim.behavior. The default value of this property, TransactionCurrency, corresponds to the elimination of CTA amounts related to intercompany transactions. To change this behavior so that it persists CTA amounts related to intercompany transactions, follow these steps:

1. Add the following argument to the JVM options for the ODCS managed servers:
-Dodcs.cta.elim.behavior=ReportingCurrency

For information about setting these options, see the SAS Intelligence Platform: Web Application Administration Guide.

2. Restart the ODCS managed servers.

---

(Optional) Configure Quick Help Display

In the solutions, Quick Help is a short Help topic that can be automatically displayed on a Web application page. By default, Quick Help display is disabled. As an administrator, you can enable or disable Quick Help display for all the solutions applications, or you can enable or disable it for individual applications.

To enable Quick Help display:

1. Log on to SAS Management Console as an administrator.

2. On the Plug-ins tab, navigate to Application Management → Configuration Manager.

3. Right-click SAS Application Infrastructure and open its properties.

4. Click the Settings tab:

5. Click the Lock button for Display Quick Help Tips.

By default, this property is locked. Unlocking the property makes it possible to change its value in components that inherit it.

6. Click OK.

7. Right-click Solutions Svc 5.1 and select Properties.
8. Click the Settings tab.

9. From the Display Quick Help Tips drop-down box, select Yes to enable Quick Help display.

10. Click OK.

11. Follow steps 7–10 for Human Cap Mgmt 5.1, Financial Mgmt 5.1, Web Data Entry 5.1, and Strategy Mgmt 5.1 (depending on the products that you installed).

12. Restart the managed servers.

For details about the Configuration Manager, see “Administering the SAS Web Infrastructure Platform” in the SAS Intelligence Platform: Web Application Administration Guide.

---

Secure Your Installation

**Configure Security Settings for Folders and Files**

Apply the operating-system protections that are recommended for configuration directories on the SAS Intelligence Platform. For instructions, see “What to Do Next: Administration Tasks” in the SAS Intelligence Platform: System Administration Guide, which is available at [support.sas.com/92administration](http://support.sas.com/92administration).

In addition, you should apply the operating-system protections that are recommended in the following table. All of these directories are located in `SAS-configuration-directory\Lev1` on the data tier.

**Table 2.1 Recommended Operating System Protections for the Solutions Configuration**

<table>
<thead>
<tr>
<th>Directories</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Appdata <code>\SASHumanCapitalManagement5.1\Cubes</code></td>
<td>Windows: Grant Modify permission to the SAS Server Users group.</td>
</tr>
<tr>
<td><code>SASApp\Data</code> and its subdirectories</td>
<td>Windows: Grant Full Control to SAS General Server User (sasrv). Grant Read/Write/Create permission to users who run ETL or SAS jobs to update data in the warehouse. These users should include the Solutions Host User (slnhost).</td>
</tr>
</tbody>
</table>
Provide the following operating system protections to the MySQL directories on the data tier:

Table 2.2 Recommended Operating System Protections for the MySQL Directories

<table>
<thead>
<tr>
<th>Directories</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>MySQL-Install-Dir</strong></td>
<td>Windows:</td>
</tr>
<tr>
<td></td>
<td>Grant Full Control to SYSTEM and Administrators only.</td>
</tr>
<tr>
<td><strong>MySQL-Install-Dir\bin</strong></td>
<td>Windows:</td>
</tr>
<tr>
<td></td>
<td>Grant Read and Execute permission to everyone.</td>
</tr>
</tbody>
</table>

Additional information:

- For an overview and detailed information about security in the SAS Intelligence Platform, see the *SAS Intelligence Platform: Security Administration Guide*.

- If you installed SAS Web Report Studio, see “Configuring SAS Web Report Studio” in the *SAS Intelligence Platform: Web Application Administration Guide*. This chapter includes information about securing the folders that are used by SAS Web Report Studio, including folders that hold temporary files.

These books are available at [support.sas.com/92administration](http://support.sas.com/92administration).

**Secure Access to MySQL**

On Windows, MySQL is installed as a system service by default. Consequently, the service has access to all directories. MySQL can be used only with its own user IDs.

*Note:* During the configuration process, several MySQL users are created, and the root user for MySQL is deleted after it is no longer needed.

To restrict the IP address that MySQL uses, perform these steps after the configuration has been validated:

1. On the machine where MySQL resides, create a file (grant.sql) with these contents (line breaks are inserted for readability):

   ```sql
   revoke all privileges, grant option from
   'sqladmin'@'\%';
   GRANT ALL PRIVILEGES ON *.* TO
   sqladmin@'datatier'
       IDENTIFIED BY 'mysqlpassword'
       WITH GRANT OPTION;
   GRANT ALL PRIVILEGES ON *.* TO
   sqladmin@'midtier'
       IDENTIFIED BY 'mysqlpassword'
       WITH GRANT OPTION;
   GRANT ALL PRIVILEGES ON *.* TO sqladmin@'localhost'
       IDENTIFIED BY 'mysqlpassword'
       WITH GRANT OPTION;
   flush privileges;
   ```

   In this file, make the following changes:

   a. Replace *mysqlpassword* with the password for MySQL.
b. Replace datatier and midtier with the fully qualified host names of the data tier and middle tier, respectively.

Save the file.

2. At a command prompt, execute this command (replacing mysqlpassword with the password for MySQL):

```sql
mysql
-usqladmin -pmysqlpassword <
grant.sql
```

Follow the same procedure for additional MySQL users (depending on the products that you installed): sassmndbdadm, hcmdbadm, and spmndbdadm.

---

**Configure a SAS Data Integration Studio User**

Configure at least one SAS Data Integration Studio user for the solutions, as follows:

1. If necessary, create a user ID and password on the host machine on which the jobs are being submitted.

   This user must not be the unrestricted user. If you log on as the unrestricted user, then you cannot attach the libraries that are necessary to run SAS Data Integration Studio.

   On Windows, SAS Data Integration Studio users must have the **Log on as a batch job** right. For more information, see “Windows Privileges” in the *SAS Intelligence Platform: Security Administration Guide*.

2. In the folder's security properties in the operating system, grant Read/Write/Create permission to the user for the directory where the data warehouse resides (that is, `SAS-config-dir\Level1\SASApp\Data` and its subdirectories).

3. In SAS Management Console, create the user (if necessary) and add the user to the following groups and roles:

   - **Solutions Users group**
     
     This group is a member of the SASSDM MySQL Users group, which has a login to the SASSDM database. The Solutions Users group also has permission for the SDMMET library. This permission is necessary for running metrics jobs.

   - **HCM Solution Users group (for SAS Human Capital Management)**
     
     This group is a member of the HCM MySQL Users group, which has a login to the HCM database. The HCM Solution Users group also has permission for the HCM library.

   - **SPM MySQL Users group (for SAS Strategy Management)**
     
     This group has a login to the SPM database.

   - **Data Administrator role**
(SAS Financial Management; Optional) Verify Using Sample Data

Overview

Sample data is provided to help you verify the correct operation of the software and to demonstrate functionality of the solutions. After verification, you can run batch programs to load the DDS, stageDDS, and SASSDM databases again. These batch programs reset the databases to their default state (the state they were in right after a new installation and configuration).

CAUTION:

If this installation is the result of a migration, or if you have already stored data that you want to keep, do not load the sample data or run the batch programs.

Here is an overview of the verification procedure:

1. Download scripts and batch programs that are used for loading sample data and reloading the databases.
2. Log on to the data-tier server.
3. Load the sample data.
4. Restart the managed servers.
5. Verify the installation.
6. Reset the databases to their default state.
7. Restart the managed servers.

Download Scripts and Batch Programs

Before loading the sample data, download replacements for the fmsdata.sql and sassdm.sql scripts as well as a batch program to reset the databases after verification:

1. On the SAS support site, navigate to SAS Note 37431 (http://support.sas.com/kb/37/431.html).
2. Download the scripts that are available in that SAS Note.
3. On the data tier, copy the fmsdata.sql and sassdm.sql scripts to the Program Files \SAS\SASSolutionsServicesDataTier\5.1\SampleData\sassdm directory, replacing the scripts with the same name in that directory.
5. Download the batch files that are available in that SAS Note.
6. On the data tier, copy the restore_original_install_data_fm.bat file to the SAS-config-dir\Lev1\Applications \SASSolutionsServices5.1\SampleData directory.
Load Sample Data

Load Sample Data for the Cross Industry Detail Data Store
Running the LoadDDSSampleData script replaces all the tables in the Cross Industry Detail Data Store (DDS) as well as the staging tables (stageDDS).

1. At a command prompt, change directory to `SAS-config-dir\Lev1\Applications\SASSolutionsServices5.1\SampleData`.
2. Run the script to load the DDS and stageDDS sample data:
   `LoadDDSSampleData.bat`
3. When prompted, enter the following connection information:

<table>
<thead>
<tr>
<th>Prompt</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAS Metadata User ID</td>
<td>User ID of the unrestricted user (for example, sasadm@saspw).</td>
</tr>
<tr>
<td>SAS Metadata User Password</td>
<td>User password.</td>
</tr>
</tbody>
</table>

Load Sample Data for Solutions Data Mart
Running the LoadSASSDMSampleData script populates tables in the Solutions data mart (SASSDM).

1. At a command prompt, change directory to `SAS-config-dir\Lev1\Applications\SASSolutionsServices5.1\SampleData`.
2. Run the script to load the SAS Solution Services sample data:
   `LoadSASSDMSampleData.bat`
3. When prompted, enter the following connection information:

<table>
<thead>
<tr>
<th>Prompt</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MySQL Host Name</td>
<td>Name of the host machine where MySQL is running</td>
</tr>
<tr>
<td>MySQL DB Name</td>
<td>sassdm</td>
</tr>
<tr>
<td>MySQL Port (default:3306)</td>
<td>MySQL port number. 3306 is the default port number.</td>
</tr>
<tr>
<td>MySQL DB User ID</td>
<td>User ID for accessing the SASSDM database.</td>
</tr>
<tr>
<td>MySQL DB User Password</td>
<td>Password for accessing the SASSDM database.</td>
</tr>
</tbody>
</table>

Load Sample Data for Operational Planning
Running the LoadOPPLANSampleData script creates tables in the Solutions data mart (SASSDM). These tables are used for operational planning in SAS Financial Management.
1. At a command prompt, change directory to \SAS-config-dir\Level\Applications\SASSolutionsServices5.1\SampleData.

2. Run the script to load the sample data for operational planning to the SASSDM database:

   LoadOPPLANSampleData.bat

3. When prompted, enter the appropriate connection information for the SASSDM database.

<table>
<thead>
<tr>
<th>Prompt</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MySQL Host Name</td>
<td>Name of the host machine where MySQL is running</td>
</tr>
<tr>
<td>MySQL DB Name</td>
<td>sassdm</td>
</tr>
<tr>
<td>MySQL Port (default:3306)</td>
<td>MySQL port number. 3306 is the default port number.</td>
</tr>
<tr>
<td>MySQL DB User ID</td>
<td>User ID for accessing the SASSDM database.</td>
</tr>
<tr>
<td>MySQL DB User Password</td>
<td>Password for accessing the SASSDM database.</td>
</tr>
</tbody>
</table>

**Verify the Installation**

**About SAS Financial Management Verification**

After you load the sample data, restart SASServer3 and the ODCS managed servers.

To verify the Web application components of SAS Financial Management, follow the steps in the Instructions.html file on the middle tier. The remaining sections in this topic include verification instructions for SAS Financial Management Studio and the SAS Financial Management Add-In for Microsoft Excel.

For the SAS Financial Management verification instructions, you need only the SAS Demo User, who must belong to the following groups and roles:

- Solutions Users (group)
- Analyst (role)
- Finance Process Administrator (role)

Those groups and roles are assigned by default to the SAS Demo User.

If you create additional users or groups, you must synchronize users and groups by running the Import Users and Groups stored process. For details, see “Running the Import Users and Groups Stored Process” on page 45.

**SAS Financial Management Studio**

*Note:* For installation instructions, see “SAS Financial Management Studio and SAS Solutions Services Dimension Editor” on page 69.

Follow these steps:

1. Log on to SAS Financial Management Studio as the SAS Demo User (sasdemo).
2. Examine the dimensions in the Dimensions workspace.
3. Expand the Account dimension and view these sample hierarchies:
   - ACCOUNT_MR
   - ACCOUNT_Sal
   - ACCOUNT_TH

4. Examine the default model in the Models workspace.

5. Created an Operational Planning Cycle, as follows:
   a. Select File ➔ New Cycle.
   b. Type in a Name and Description.
   c. From the Type radio buttons, select Operational planning cycle. Click Next.
   d. On the Required Dimensions page, accept the defaults and click Next.
   e. On the Other Dimensions page, select the PRODUCT dimension in the Available list and click the arrow to move it to the Selected list. Click Next.
   f. On the Time Hierarchy page, accept the default values and click Next.
   g. On the Time Span page, select JAN2002 as the Start member, and DEC2002 as the End member. Click Next.
   h. On the Summary page, click Finish.

6. Select File ➔ Open Cycle and select your newly created operational planning cycle.
   You might see a message stating that the cycle has no models. You can ignore this message. (A cycle must exist before you can create a model for that cycle.)

**SAS Financial Management Add-In for Microsoft Excel**

*Note:* For installation instructions, see “The Add-In Clients for Microsoft Office” on page 70.

To verify the operation of the SAS Financial Management Add-In for Microsoft Excel, follow these steps:

1. Open a workbook in Microsoft Excel.

2. From the SAS Solutions menu, select Log on and log on to the middle tier as the SAS Demo User (sasdemo).

3. Insert a read-only table:
   a. Select SAS Solutions ➔ Insert ➔ Read-only table.
   b. Select the Default_Model.
   c. Use the arrows to make the following selections:
      - **Rows:** Account
      - **Columns:** Time
      - **Slicers:** Analysis, Organization, Frequency, and Product
   d. Make further selections in the rest of the wizard or click Finish to accept the defaults.
**Reset the DDS, stageDDS, and SASSDM Databases**

On the data tier, follow these steps to reset the DDS, stageDDS, and SASSDM databases to their default state:

1. At a command prompt, change directory to `SAS-config-dir\Lev1\Applications\SASSolutionsServices5.1\SampleData`.

2. Run the script:
   ```bash
   restore_original_install_data_fm.bat
   ```
   When prompted, enter the following connection information:

<table>
<thead>
<tr>
<th>Prompt</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DB_HOST</td>
<td>Name of the host machine where MySQL is running</td>
</tr>
<tr>
<td>DB_PORT</td>
<td>Port number for MySQL (default: 3306)</td>
</tr>
<tr>
<td>DB_USERID</td>
<td>User ID for accessing the SASSDM database</td>
</tr>
<tr>
<td>DB_PASSWD</td>
<td>Password for accessing the SASSDM database</td>
</tr>
<tr>
<td>META_USER_ID</td>
<td>User ID of the unrestricted user (for example, sasadm@saspw)</td>
</tr>
<tr>
<td>META_USER_PW</td>
<td>Metadata user password.</td>
</tr>
</tbody>
</table>

   The batch program runs several SAS registration programs. The logs from these programs are in the `SAS-config-dir\Lev1\Logs\Configure` directory.

3. If the locations of `sas.exe`, the SAS configuration file (`SASV9.CFG`), and SAS registration programs are incorrectly assigned in the batch program, the program displays an error message and quits. Modify the appropriate variables and rerun the program. The following variables might need modification:
   - SAS_EXE
   - SAS_CONFIG
   - REG_STAGEDDS_DDS
   - REG_COMMON
   - REG_ODCS
   - REG_FM
   - REG_OP

   *Note:* In the SET statements, do not use spaces around the equal sign (=).

4. Restart the managed servers.

   You do not need to restart SASServer1 or SASServer2, but you must restart the other managed servers.
(SAS Human Capital Management; Optional) Verify Using Sample Data

Overview

Sample data is provided to help you verify the correct operation of the software and to demonstrate functionality of the solutions. After verification, you can run batch programs to load the DDS, stageDDS, and HCM databases again. These batch programs reset the databases to their default state (the state they were in right after installation and configuration).

**CAUTION:**

If this installation is the result of a migration, or if you have already stored data that you want to keep, do not load the sample data or run the batch programs.

The installer or data administrator should load the sample data. Here is an overview of the procedure.

1. Before loading the sample data, download and install the batch program from SAS Note 37662.
2. Log on to the data-tier server.
3. Load the sample data for the Cross Industry Detail Data Store (DDS) and the staging tables (stageDDS).
4. Load the sample data for the HCM data mart.
5. Restart the managed servers.
6. Rebuild cubes and information maps.
7. Verify the installation.
8. Reset the databases to their default state.
9. Restart the managed servers.

**Download the Batch Program**

Before loading the sample data, download a batch program to reset the database after verification:

1. On the SAS support site, navigate to SAS Note 37662 ([http://support.sas.com/kb/37/662.html](http://support.sas.com/kb/37/662.html)).
2. Download the batch files that are available in that SAS Note.
3. On the data tier, copy the restore_original_install_data_hcm.bat file to the `SAS-config-dir\Lev1\Applications\SASHumanCapitalManagement5.1\SampleData` directory.
**Load the Sample Data**

**Load Sample Data for the Cross Industry Detail Data Store**
Running the LoadDSSampleData script replaces all the tables in the Cross Industry Detail Data Store (DDS) as well as the staging tables (stageDDS).

1. At a command prompt, change directory to `SAS-config-dir\Lev1\Applications\SASSolutionsServices5.1\SampleData`.
2. Run the script to load the DDS and stageDDS sample data:
   ```
   LoadDSSampleData.bat
   ```
3. When prompted, enter the following connection information:

<table>
<thead>
<tr>
<th>Prompt</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAS Metadata User ID</td>
<td>User ID of the unrestricted user (for example, sasadm@saspw).</td>
</tr>
<tr>
<td>SAS Metadata User Password</td>
<td>User password.</td>
</tr>
</tbody>
</table>

**Load the HCM Sample Data**
If you have installed SAS Human Capital Management, you can also run the LoadHCMSampleData command, which populates tables in the HCM database with fictitious employee data.

1. At a command prompt, change directory to `SAS-config-dir\Lev1\Applications\SASHumanCapitalManagement5.1\SampleData`.
2. Run the script to load the sample data:
   ```
   LoadHCMSampleData.bat
   ```
3. When prompted, enter the following connection information:

<table>
<thead>
<tr>
<th>Prompt</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MySQL Host Name</td>
<td>Name of the host machine where MySQL is running</td>
</tr>
<tr>
<td>MySQL DB Name</td>
<td>hcm</td>
</tr>
<tr>
<td>MySQL Port (default:3306)</td>
<td>MySQL port number. 3306 is the default port number.</td>
</tr>
<tr>
<td>MySQL DB User ID</td>
<td>User ID for accessing the HCM database.</td>
</tr>
<tr>
<td>MySQL DB User Password</td>
<td>Password for accessing the HCM database.</td>
</tr>
<tr>
<td>SAS Metadata User ID</td>
<td>User ID of the unrestricted user (for example, sasadm@saspw).</td>
</tr>
<tr>
<td>SAS Metadata User Password</td>
<td>User password.</td>
</tr>
</tbody>
</table>
After you load the sample data for SAS Human Capital Management, copy the %CODENODE macro so that it can be used by the ETL job that loads the MODELSCORES table. Follow these steps:

1. On the data tier, find the codenode.sas file at `Program Files\SAS\SASHumanCapitalManagementDataTier\5.1\SampleData`.
2. Copy the file to `SAS-config-dir\Lev1\SASApp\SASEnvironment\HumanCapitalManagement\SASMacro`.

For details about the related ETL job, see the *SAS Solutions Services: Data Administration Guide*.

**Verify the Installation**

**Prepare for Verification**

After you load the sample data:

1. Rebuild the cubes and information maps. The Administration application of SAS Human Capital Management has utilities to rebuild these objects. There are also jobs for building cubes and information maps in SAS Data Integration Studio (see the *SAS Solutions Services: Data Administration Guide*).
2. In SAS Management Console, make sure that the SAS Demo User belongs to the HCM Solution Users group and has the HCM Administrator role.
3. Using the MySQL Query Browser, add an entry for the SAS Demo User to the HCM.SAS_USER_EMPLOYEE table.
   - Enter a USER_ID of “sasdemo” and an EMPLOYEE_ID of “10433”.
4. Restart SASServer3.

**Run the Diagnostic Utility**

Before running any of the SAS Human Capital Management applications, we recommend running the Diagnostic utility:

1. Make sure that you have installed the JUnit.jar file. (See “Add the JUnit JAR File” on page 10.)
2. If necessary, modify the diagnostics configuration file. (See “Modify the Diagnostics Configuration File” on page 8.)
3. On the middle tier, run the diagnostics. From the Windows Start menu, use the shortcut at `All Programs ⇒ SAS ⇒ SAS Configuration ⇒ Config - Lev1`.

For details about running the diagnostics, see “Configuring SAS Human Capital Management” in the *SAS Human Capital Management: Administrator's Guide*.

**Log on to SAS Human Capital Management**

To verify the Web applications that are part of SAS Human Capital Management, follow these steps:

2. On the Home page, enter a string such as “smith” and click **Search**.
3. On the search results page, click the SAS logo to return to the Home page.
4. From the **Tasks** list, try one or more of the following links:
   - My Employee Profile
   - New Organization Analysis
   - New Geographic Analysis
   - My Portal
5. From the **Manage** list, try the following links:
   - Workspace
   - Administration

**Reset the DDS, stageDDS, and HCM Databases**

On the data tier, follow these steps to reset the DDS, stageDDS, and HCM databases to their default state:

1. At a command prompt, change directory to `SAS-config-dir\Lev1\Applications\SASHumanCapitalManagement5.1\SampleData`.
2. Run the script:
   
   `restore_original_install_data_hcm.bat`

   When prompted, enter the following connection information:

<table>
<thead>
<tr>
<th>Prompt</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DB_HOST</td>
<td>Name of the host machine where MySQL is running</td>
</tr>
<tr>
<td>DB_NAME</td>
<td>Name of the MySQL database to be restored (HCM)</td>
</tr>
<tr>
<td>DB_PORT</td>
<td>Port number for MySQL (default: 3306)</td>
</tr>
<tr>
<td>DB_USERID</td>
<td>User ID for accessing the HCM database</td>
</tr>
<tr>
<td>DB_PASSWD</td>
<td>Password for accessing the HCM database</td>
</tr>
<tr>
<td>META_USER_ID</td>
<td>User ID of the unrestricted user (for example, sasadm@saspw).</td>
</tr>
<tr>
<td>META_USER_PW</td>
<td>Metadata user password.</td>
</tr>
</tbody>
</table>

   The batch program runs several SAS registration programs. The logs from these programs are in the `SAS-config-dir\Lev1\Logs\Configure` directory.

3. If the locations of sas.exe, the SAS configuration file (SASV9.CFG), and SAS registration programs are incorrectly assigned in the batch program, the program displays an error message and quits. Modify the appropriate variables and rerun the program. The following variables might need modification:
   - SAS_EXE
   - SAS_CONFIG
• REG_STAGEDDS_DDS
• REG_HCM

Note: In the SET statements, do not use spaces around the equal sign (=).

4. Restart the managed servers.

You do not need to restart SASServer1 or SASServer2, but you must restart the other managed servers.

---

**(SAS Strategy Management; Optional) Verify Using a Sample Project**

A sample project, KPI, is included with SAS Solutions Services. You can use this project to verify the installation of SAS Strategy Management.

1. With the URL that is provided in Instructions.html, log on to the SAS Information Delivery Portal as the SAS Demo User (sasdemo).

2. Select **Options ⇒ Edit Page Content** and add the Performance Dashboard portlet to the Home page.

3. Edit the portlet to add some KPIs.
   a. Set the **Template** to **KPI Template**.
   b. Under **Items to display in portlet**, click **Add**.
   c. Select one or more KPIs from the **Items** list and click **Add & Close**.
   d. From the **Date** section, select **Always show this date** and set the date to June 1, 2004.
   e. Click **Save**.

4. Observe the KPIs in the Performance Dashboard portlet.

5. Log off and close the browser.

---

**Create the Site’s Users and Groups**

Register users at the site and assign them to groups and roles. For instructions, see Chapter 3, “Assigning Groups and Roles,” on page 29.

Note: In order for users to access a standard workspace server using credential-based host authentication, they need the local **Log on as a batch job** right on that machine. For more information, see “Windows Privileges” in the *SAS Intelligence Platform: Security Administration Guide*.
Load Production Data

For instructions about loading production data, see the SAS Solutions Services: Data Administration Guide at support.sas.com/documentation/solutions/admin/index.html.

If you installed SAS Human Capital Management: After loading production data, rebuild the cubes and information maps, either in the Administration application of SAS Human Capital Management or via SAS Data Integration Studio jobs.

Install Client Applications

After installing the servers, system administrators can install some client applications on the users’ machines. Alternatively, users can install these clients themselves.

For descriptions of these applications and installation instructions, see Chapter 8, “Installing the Client Applications,” on page 67.

Check SAS Notes for Additional Information

We recommend that you check the SAS Notes for additional information and support fixes. Go to support.sas.com/notes.
Overview of Users, Groups, and Roles

Introduction

A metadata identity is created when you define an individual user or group in the User Manager plug-in to the SAS Management Console, or when you import user and group definitions from an enterprise source by using SAS bulk-load macros. The authorization facility uses identity metadata to define who is granted or denied permission to access a resource.

The users of a solution are typically the business users in a particular domain, such as finance. A site's administrator must load all of the appropriate information for each user.
who requires access to the solution. This chapter describes the default metadata identities (representing users, groups, and roles) that are required by SAS Solutions Services and the solutions, as well as the identities that need to be created on site.

Additional information:

• For detailed information about authentication and authorization, see the SAS Intelligence Platform: Security Administration Guide.

• The SAS Intelligence Platform configures a default set of users, groups, and roles during the deployment process. For information about those identities, see “Understanding the State of Your System” in the SAS Intelligence Platform: System Administration Guide.

These books are available at support.sas.com/documentation.

Role Membership in SAS Solutions Services

About Groups and Roles
It is important to understand the difference between groups and roles, and the privileges that each conveys. In SAS Solutions Services, group membership determines which content a user has access to, whereas role membership determines the actions a user can perform with this content. Role assignments can control the menus and links that are displayed in an application, and they can determine a user's ability to perform a task such as deleting a file in Document Manager or approving a form in a workflow.

Note: Unlike groups, roles are not hierarchical; they do not inherit properties from other roles.

How Role Permissions Are Enforced
Permissions that are based on roles are enforced in two different ways:

• Document manager. For each content type, such as WebDocument or ExcelReport, there is a defined set of actions, such as Move, AddtoPortlet, and Comment. In Document Manager, roles are granted permission to perform various actions based on content type. These permissions should not be changed at a site.

  If a user has one role that grants an action for a particular content type and another role that denies the same action, then the least restrictive permission applies. If a user is directly granted or denied permission to perform an action, then the user's grant or denial applies, regardless of any roles the user might belong to.

• The solutions. In the solutions, roles are enforced by the application. Each application determines the functionality that is permitted to various roles.

SAS Solutions Services Users, Groups, and Roles

SAS Solutions Services User Identities
SAS Solutions Services has two default user identities: Solutions Host User and SAS Solutions Administrator.
### SAS Solutions Services Groups

<table>
<thead>
<tr>
<th>Group</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solutions Users</td>
<td>Members of the Solutions Users group are able to access the Document Manager, are configured to run solutions stored processes, and have default portal customization capabilities, such as adding a portlet or modifying its content. Solutions Users is a member of the SASSDM MySQL Users group. Any users who run metric jobs or access the metric tables must be a member of the Solutions Users group, which has access to the SDMMET library.</td>
</tr>
<tr>
<td>Administrators</td>
<td>Members of this group should also belong to the Solutions Users group. Membership in this group grants certain default privileges in Document Manager. It also grants superuser status in SAS Financial Management Studio. Membership in this group should be granted sparingly.</td>
</tr>
<tr>
<td>SASSDM MySQL Users</td>
<td>This group grants access to users who run stored processes and ETL processes that reference MySQL tables in the SASSDM database. The group has a login to the SASSDM database.</td>
</tr>
</tbody>
</table>

### SAS Solutions Services Roles

SAS Solutions Services has the following default roles:
<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analyst</td>
<td>Users with the Analyst role can view, edit, move, and delete authorized content. In SAS Strategy Management and in SAS Financial Management, the Analyst role confers an additional set of privileges. The role is the same, but its functionality depends on the application that is being used.</td>
</tr>
<tr>
<td>Dimension Modeler</td>
<td>This role gives users access to the SAS Solutions Services Dimension Editor, a Java client application for creating and modifying dimensions and hierarchies. The role has additional functionality within SAS Financial Management Studio. See “SAS Financial Management Roles” on page 35.</td>
</tr>
<tr>
<td>Data Administrator</td>
<td>Users need this role to run jobs in SAS Data Integration Studio.</td>
</tr>
<tr>
<td>Information Consumer</td>
<td>Users with this role can view content. These users cannot create, move, or delete content.</td>
</tr>
<tr>
<td>System Administrator</td>
<td>Users with this role have access to all functionality within the Document Manager.</td>
</tr>
</tbody>
</table>

Note: The Information Consumer, Analyst, and System Administrator roles are not required for SAS Human Capital Management.

SAS Strategy Management Groups and Roles

SAS Strategy Management Groups

The following groups are part of SAS Strategy Management:

<table>
<thead>
<tr>
<th>Group</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analyst Group</td>
<td>Members of this group have the Analyst role. In SAS Strategy Management, users with the Analyst role can view tables, aggregate tables, diagrams, associations, and ranges. They can edit column selections and set personal thresholds and formats, as well as access and customize historical trend charts. In addition, these users can manage and use data-entry forms. Unlike Scorecard Modelers, Analysts cannot create or modify scorecard projects.</td>
</tr>
<tr>
<td>Data Administrators Group</td>
<td>Members of this group have the Data Administrator role, which is required for all SAS Data Integration Studio users.</td>
</tr>
<tr>
<td>Group</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Information Consumer Group</td>
<td>Members of this group have the Information Consumer role, which has privileges similar to the Scorecard Data Entry role.</td>
</tr>
<tr>
<td>Scorecard Data Entry Group</td>
<td>Members of this group have the Scorecard Data Entry role. Users with this role can view tables in projects and scorecards, subject to authorization. They use these tables to manage and use data-entry forms.</td>
</tr>
<tr>
<td>Scorecard Modeler Group</td>
<td>Members of this group have the Scorecard Modeler role. Users with the Scorecard Modeler role can create scorecard projects and can fully manage the content of templates, projects, and scorecards that they are authorized to view, edit, and delete. They have administrative privileges only for projects and scorecards that they create.</td>
</tr>
<tr>
<td>Solutions Administrators Group</td>
<td>Members of this group have the System Administrator role.</td>
</tr>
<tr>
<td>SPM MySQL Users</td>
<td>This group has a login to the SPM database in MySQL.</td>
</tr>
<tr>
<td>SPM Users</td>
<td>All SAS Strategy Management users should belong to this group. A user must be a member of the SPM Users group in order to be an owner of a SAS Strategy Management object.</td>
</tr>
</tbody>
</table>

**SAS Strategy Management Roles**

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analyst</td>
<td>For information about these roles, see the description of the corresponding groups. In SAS Strategy Management, users should be assigned to the groups, rather than to the roles.</td>
</tr>
<tr>
<td>Information Consumer</td>
<td></td>
</tr>
<tr>
<td>Scorecard Data Entry</td>
<td></td>
</tr>
<tr>
<td>Scorecard Modeler</td>
<td></td>
</tr>
</tbody>
</table>
## Example: SAS Strategy Management Users

### Table 3.1  SAS Strategy Management: Typical Users

<table>
<thead>
<tr>
<th>Typical Users</th>
<th>Tasks</th>
<th>Groups and Roles (Optional*)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data entry personnel</td>
<td>These users enter data into forms for scorecards.</td>
<td>Groups:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• SPM Users</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Scorecard Data Entry Group</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Solutions Users</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Information Consumer Group</td>
</tr>
<tr>
<td>Analysts</td>
<td>These users analyze and create reports, view scorecard information, and perform other similar tasks. They can customize a scorecard but cannot create or manage scorecards.</td>
<td>Groups:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• SPM Users</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Analyst Group</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Solutions Users</td>
</tr>
<tr>
<td>Scorecard modelers</td>
<td>These users create and manage scorecard projects and templates. They can export projects or parts of a project (such as scorecards or measures), depending on their permissions. Optional:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• With the Dimension Modeler role, these users can edit dimensions and hierarchies with the SAS Solutions Services Dimension Editor.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• With the appropriate permissions, these users can create and administer dashboards with SAS BI Dashboard.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Groups:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• SPM Users</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Scorecard Modeler Group</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Solutions Users</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Roles:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Dimension Modeler*</td>
</tr>
<tr>
<td>Administrators</td>
<td>These users might perform several types of administrative tasks at a site, including content administration, data administration, and IT administration. Content administration tasks might include managing folders in SAS Management Console or Document Manager. With the SASSDM MySQL Users group and Data Administrators Group, the users can perform data administration tasks such as loading data from source systems into SAS Strategy Management via SAS Data Integration Studio. If users need access to the SAS Strategy Management Web application, they must belong to the SPM Users group and the Scorecard Modeler Group.</td>
<td>Groups:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Administrators</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Data Administrators Group</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• SPM MySQL Users</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• SASSDM MySQL Users</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Solutions Administrators Group</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Solutions Users</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• SPM Users*</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Scorecard Modeler Group*</td>
</tr>
</tbody>
</table>

For information about roles and permissions for SAS BI Dashboard, see “Managing Security for SAS BI Dashboard” in the *SAS Intelligence Platform: Web Application Administration Guide*. 

SAS Financial Management Groups and Roles

About SAS Financial Management Groups and Roles

SAS Financial Management uses several roles. Some roles apply to SAS Financial Management Studio. Other roles apply to creating and viewing reports in Microsoft Excel, or to submitting and approving forms.

SAS Financial Management Roles

The following roles are used in SAS Financial Management:

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analyst</td>
<td>A user with this role can export values to a metric table that can be used in SAS Strategy Management or the KPI Viewer, using the Export as Measure feature of the SAS Financial Management Add-In for Microsoft Excel.</td>
</tr>
<tr>
<td>Finance Adjuster</td>
<td>(SAS Financial Management Studio)</td>
</tr>
<tr>
<td></td>
<td>A user with this role is typically a financial specialist who performs manual adjustments and creates or edits adjustment rules. Users with this role have the following privileges:</td>
</tr>
<tr>
<td></td>
<td>• all features of the Models workspace except for creating and editing unbalanced manual adjustments</td>
</tr>
<tr>
<td></td>
<td>• Read access to the Dimensions, Cycles, Rates, and Forms workspaces</td>
</tr>
<tr>
<td>Finance Process Administrator</td>
<td>This role applies to an administrator who configures SAS Financial Management, creates cycles, rates, and form sets, manages data security, exports measures, and performs other administration tasks. Users with this role can use all the features of SAS Financial Management Studio.</td>
</tr>
<tr>
<td></td>
<td>In the Form Manager, users with this role perform tasks such as freeing a form that is stuck in the workflow process. They have access to all currently active forms, and they can enter data in forms and can approve forms.</td>
</tr>
<tr>
<td></td>
<td>If a user with this role also belongs to the Administrators group, the user has full access to SAS Financial Management objects (cycles, result models, and composite results), regardless of permissions on these objects.</td>
</tr>
<tr>
<td></td>
<td>However, member-level security (for cell data) still applies. For details, see the online Help for SAS Financial Management Studio.</td>
</tr>
</tbody>
</table>
### Role and Description

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
</table>
| Dimension Modeler             | (SAS Financial Management Studio)  
Finance Adjusters with the Dimension Modeler role have access to all features of the Dimensions workspace.  
(Without the Dimension Modeler role, Finance Adjusters have read-only access to this workspace.)  
This role also provides access to the SAS Solutions Services Dimension Editor. |
| Form Submitter                | (Financial forms only)  
Users with the Form Submitter role are primarily data-entry personnel who enter data in forms and submit them for approval, as part of a budgeting or similar process. They have access only to the forms that they have some responsibility for. |
| Form Approver                 | (Financial forms only)  
Users with the Form Approver role can approve forms that they have responsibility for and send them to the next stage in the approval process. |
| Planning Data Entry User      | (Operational forms only)  
In an operational form set, an assigned author or reviewer must have the Planning Data Entry User role.  
Unlike financial form sets, an operational form set can have only one author and only one reviewer. Both the author and reviewer need the Planning Data Entry User role. |

The need for the Form Submitter and Form Approver roles depends in part on the workflow that the users participate in.

- **Top-down workflows.** In a top-down workflow, data is entered at the highest level of the hierarchy and pushed down to lower levels.

  All users need the **Form Submitter** role so that they can edit a form, if necessary, and push it to the next level.

- **Bottom-up workflows.** In a bottom-up workflow, data is entered at the lowest level of the hierarchy (in the leaf forms) and submitted for approval to the next higher level in roll-up forms. Required roles:
  - **Form Submitter.** All users who might edit forms need the Form Submitter role.
  - **Form Approver.** All users who need to approve forms need the Form Approver role.

If a user is assigned as the author for a roll-up form, then that user must have the Form Submitter role in order to submit the form to the next-level approver. If that user is also responsible for approving all leaf forms below that form, then the user must also have the Form Approver role, as shown in this example:

- WW: Author=Fred (Form Submitter role, Form Approver role)
  - USA: Author=Mary (Form Submitter role), Approver=Fred
  - Europe: Author=Jean (Form Submitter role), Approver=Fred
However, it is possible to design a workflow in which some users are only approvers, while other users are only form submitters. In this example, one user is assigned to roll up a form, while a different user approves leaf forms:

- WW: Author=Fred (Form Submitter role)
  - USA: Author=Mary (Form Submitter role), Approver=Carl (Form Approver role)
  - Europe: Author=Jean (Form Submitter role), Approver=Carl


### Example: SAS Financial Management Users

The following table includes a list of typical users, the tasks that each user needs to accomplish, and the predefined groups and roles that are required for those tasks.

For a particular site, you might create a set of custom groups (sometimes called personas) that reflect the capabilities that are needed at the site. You would then assign these custom groups to the appropriate predefined groups and roles. You could also assign individual users to the predefined groups and roles. However, using custom groups simplifies maintenance.

#### Table 3.2 SAS Financial Management: Typical Users

<table>
<thead>
<tr>
<th>Typical Users</th>
<th>Tasks</th>
<th>Groups and Roles (Optional*)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report viewers</td>
<td>These users can open reports from a portlet or from Document Manager. If SAS Financial Management Add-In for Microsoft Excel is installed, the users can interact with dynamic reports and can save different versions of existing reports, depending on folder write permissions. They cannot log on directly to the middle tier from Microsoft Excel and cannot log on to SAS Financial Management Studio. Optional: • With the Scorecard Data Entry role, these users can enter data into forms for scorecards. They can access only projects and scorecards that they are authorized to view. They use these tables to manage and use data-entry forms. • With the appropriate permissions, users can view reports in SAS Web Report Studio.</td>
<td>Groups: • Solutions Users Roles: • Information Consumer • Scorecard Data Entry*</td>
</tr>
</tbody>
</table>
# Typical Users

<table>
<thead>
<tr>
<th>Groups and Roles (Optional*)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Report creators</strong></td>
</tr>
</tbody>
</table>
| These users can create reports using the SAS Financial Management Add-In for Microsoft Excel with existing models. Because they have the Analyst role, they can export values to a metric table that can be used in SAS Strategy Management or the KPI Viewer. The users can log on directly to the middle tier from Microsoft Excel and can save reports to shared areas, depending on folder permissions. They cannot log on to SAS Financial Management Studio. Optional:  
  - With the Scorecard Data Entry role, these users can enter data into forms for scorecards. They can access only projects and scorecards that they are authorized to view. They use these tables to manage and use data-entry forms. |
| Groups:  
  - Solutions Users  
  Roles:  
  - Analyst  
  - Scorecard Data Entry* |
| **Budget submitters**       |
| These users can enter data and submit planning forms via the Financial Form Manager. Depending on folder write permissions, these users are limited to sharing existing forms to their personal folders. They cannot design or publish form sets. With the SAS Financial Management Add-In for Microsoft Excel, these users can create reports. With the HCM Solution Users group and the HCM User role, these users can participate in the budgeting process for SAS Human Capital Management. (This capability requires SAS for Workforce Planning and Budgeting.) |
| Groups:  
  - Solutions Users  
  - HCM Solution Users*  
  Roles:  
  - Form Submitter  
  - HCM User* |
| **Budget approvers**        |
| These users can approve planning forms via the Financial Form Manager. Depending on folder write permissions, these users are limited to sharing existing forms to their personal folders. They cannot design or publish form sets. With the SAS Financial Management Add-In for Microsoft Excel, these users can create reports. With the HCM Solution Users group and the HCM User role, these users can participate in the budgeting process for SAS Human Capital Management. (This capability requires SAS for Workforce Planning and Budgeting.) |
| Groups:  
  - Solutions Users  
  - HCM Solution Users*  
  Roles:  
  - Form Submitter  
  - Form Approver (bottom-up workflows only)  
  - HCM User* |
| **Operational planning form authors or reviewers** |
| These users can edit or review an operational planning form. |
| Groups:  
  - Solutions Users  
  Roles:  
  - Planning Data Entry User |
<table>
<thead>
<tr>
<th>Typical Users</th>
<th>Tasks</th>
<th>Groups and Roles (Optional*)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data administrators</td>
<td>These users load data from source systems into SAS Financial Management via SAS Data Integration Studio. As members of the Solutions Users group, they can log on to the portal and use the Document Manager. With the Analyst role, they can run stored processes. Optional: • Any users who run metric jobs or access the metric tables must be a member of the Solutions Users group, which has access to the SDMMET library. • With the Finance process Administrator role, they can log on to SAS Financial Management Studio and update data. • With the HCM Solution Users group and the HCM Analyst role, these users can create form sets for SAS Human Capital Management. (This capability requires SAS for Workforce Planning and Budgeting.)</td>
<td>Groups: • SASSDM MySQL Users • Solutions Users* • Administrators • HCM Solution Users* Roles: • Finance Process Administrator • Data Administrator • Analyst • HCM Analyst*</td>
</tr>
<tr>
<td>IT administrators</td>
<td>These users perform IT-related tasks. For example, they manage folders in SAS Management Console or Document Manager. Optional: • With the Analyst role, they can run stored processes.</td>
<td>Groups: • Solutions Users Roles: • System Administrator • Analyst*</td>
</tr>
<tr>
<td>Functional administrators</td>
<td>The functional administrators are the power users, with full rights to SAS Financial Management Studio. They can create and modify models, cycles, dimensions, and form sets. Using the SAS Financial Management Add-In for Microsoft Excel, they can create reports. With the Analyst role, they can export values to a metric table that can be used in SAS Strategy Management or the KPI Viewer. Optional: • At least one functional administrator should be assigned to the Administrators group. A member of this group has “superuser” status in SAS Financial Management Studio and can manage all models and cycles, regardless of the permissions set on those objects. (Member-level permissions still apply, however.) • With the Scorecard Modeler role, these users can manage scorecards and key performance indicators (KPIs).</td>
<td>Groups: • Administrators* Roles: • Analyst • Finance Process Administrator • Scorecard Modeler*</td>
</tr>
</tbody>
</table>
### Typical Users

<table>
<thead>
<tr>
<th>Groups and Roles (Optional*)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Finance adjusters</td>
</tr>
</tbody>
</table>

These users have limited rights to SAS Financial Management Studio. They can create or edit models, make balanced manual adjustments, and create or edit adjustment rules.

They have read-only access to Dimensions, Cycles, Rates, and Forms workspaces, and they cannot make unbalanced manual adjustments.

Optional:
- With the Dimension Modeler role, they can access all features in the Dimensions workspace of SAS Financial Management Studio.

### Finance Adjusters

At a small site, some of these users might perform multiple functions. For example, one person might act as the data administrator, functional administrator, and IT administrator, or there might be a single group incorporating these functions.

For information about roles and permissions for SAS BI Dashboard, see “Managing Security for SAS BI Dashboard” in the *SAS Intelligence Platform: Web Application Administration Guide*.


---

### SAS Human Capital Management Groups and Roles

#### About SAS Human Capital Management Groups and Roles

SAS Human Capital Management users must meet the following qualifications:

- membership in the HCM Solution Users group
- membership in one of the following roles:
  - HCM User
  - HCM Analyst
  - HCM Administrator

*Note:* Assign users, not groups, to SAS Human Capital Management roles.

- a valid entry in the SAS_USER_EMPLOYEE table of the HCM database

For information about the ETL job that loads the SAS_USER_EMPLOYEE table, see the *SAS Solutions Services: Data Administration Guide*. You can also update this table manually, from the Administration application of SAS Human Capital Management. See the *SAS Human Capital Management: Administrator's Guide* for details.

### SAS Human Capital Management Groups

The following groups are part of SAS Human Capital Management:
<table>
<thead>
<tr>
<th>Group</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HCM Users</td>
<td>To log on to SAS Human Capital Management, users must belong to the HCM Solution Users group.</td>
</tr>
<tr>
<td>HCM MySQL Users</td>
<td>This group grants access to users who run stored processes and ETL processes that reference MySQL tables in the HCM database. It has a default login to the HCM database.</td>
</tr>
<tr>
<td>HR</td>
<td>The HR group is the default power user group. Members of this group are not subject to hierarchical filters, which are part of row-level security in SAS Human Capital Management. (Additional filters for users, groups, or roles still apply.) Each site can define its own power user group. For details, see “Securing Objects and Tables” in the <em>SAS Human Capital Management: Administrator’s Guide</em>.</td>
</tr>
</tbody>
</table>

---

**SAS Human Capital Management Roles**

SAS Human Capital Management users must be a member of one of these roles:

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
</table>
| HCM User      | Users with the HCM User role view employee, organizational, and geographic data, and create presentations and reports. These users can print information but cannot export it. They cannot create a document such as a geographic analysis, organization analysis, or a SAS report. Users with the HCM User role have these capabilities:  

- Employee Browser: view employee detail (profile view), search for employees, and edit the category list.  
- organization analysis: open and print organization charts; launch a linked scorecard; create a presentation view.  
- geographic analysis: open a geographic analysis document and drill down into the content; print a map or employee list.  
- general search: conduct a simple, advanced, or history search. |
<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
</table>
| HCM Analyst          | Users with the HCM Analyst role create the documents that are viewed by other users, including organization and geographic analyses. They can print, save, and export data. Users with the HCM Analyst role have these capabilities:  
  • Employee Browser: all functions.  
  • organization analysis: all functions. In addition to the HCM User privileges, these users can add and remove measures, create a new organization analysis, modify the display options, and simulate a reorganization.  
  • geographic analysis: all functions. These users can create or open a geographic analysis document and drill down into the content; print a map or employee list.  
  • general search: all functions, including saving and exporting search results. |
| HCM Administrator    | Users with the HCM Administrator role configure SAS Human Capital Management and manage data security. These users have full access to all functionality within SAS Human Capital Management.  
  In addition to the tasks that are described for the HCM Analyst role, these users can perform administration and configuration tasks, including importing tables, mapping hierarchies, configuring application defaults, and creating employee profiles. |

**Example: SAS Human Capital Management Users**

The following list includes some hypothetical users at a SAS Human Capital Management site: general users (managers), report creators, HR analysts, and administrators, along with the groups and roles they might belong to.

*Note:* Membership in the appropriate groups and roles does not guarantee access to data or actions. For more information, see the “Security Administration” chapter of the *SAS Human Capital Management: Administrator’s Guide.*
**Table 3.3  SAS Human Capital Management: Typical Users**

<table>
<thead>
<tr>
<th>Typical Users</th>
<th>Tasks</th>
<th>Groups and Roles (Optional*)</th>
</tr>
</thead>
</table>
| **Managers**  | These managers view and interact with reports. They can log on to SAS Human Capital Management, browse employees, and interact with a geographic analysis or organization analysis. They can print but cannot save data from those applications. They can also execute the standard stored processes. Optional:  
• With the Scorecard Data Entry role, these users can view KPIs and scorecards (depending on permissions).  
• With the Form Submitter role or the Form Approver role, users can participate in the budgeting process. (This capability requires SAS for Workforce Planning & Budgeting.)  
• With the appropriate role, users can view and interact with reports in SAS Web Report Studio.  
• With the appropriate permissions, users can view a BI Dashboard on the Home page or in a portlet. | Groups:  
• HCM Solution Users  
Roles:  
• HCM User  
• Scorecard Data Entry*  
• Form Submitter*  
• Form Approver* |
| **Report Creators** | These users create reports for others to view and interact with. They can log on to SAS Human Capital Management and browse employees, create a geographic analysis, and create an organization analysis. They can save or export data from those applications. They can also execute the standard stored processes. Optional:  
• With the Scorecard Modeler role and the SPM Users group, these users can create and manage KPIs and scorecards. With the Analyst role, they can customize a scorecard or KPI but cannot create or manage them.  
• With the appropriate role and permissions, users can create and administer dashboards in SAS BI Dashboard.  
• With the appropriate role, users can create reports in SAS Web Report Studio. | Groups:  
• HCM Solution Users  
• SPM Users  
Roles:  
• HCM Analyst  
• Analyst* or Scorecard Modeler* |
| **HR analysts** | These users perform statistical analyses of the data in SAS Human Capital Management. Because they need access to all the data, they might need to belong to the HR (superuser) group. Membership in the HR group enables a user to access records for all employees, regardless of hierarchical filters. However, other filters might apply.  
*Note:* Because some data is quite sensitive, use care in assigning membership in the HR group.  
If these users need to create reports as well as analyze them, they need the same groups and roles as report creators. | Groups:  
• HCM Solution Users  
Roles:  
• HCM User  
• Scorecard Data Entry**
Typical Users | Tasks | Groups and Roles (Optional*)
---|---|---
Administrators | These users have access to the full functionality of SAS Human Capital Management. They might perform several types of administrative tasks at a site, including content administration, data administration, and IT administration. If the site has SAS for Workforce Planning & Budgeting, these users can create planning measures for use in the budgeting process. Optional:
• With the Data Administrator role, the users can run jobs in SAS Data Integration Studio.
• If these users need to create or modify reports, they will also require the additional groups and roles that report creators have.
• Any users who run metric jobs or access the metric tables must be a member of the Solutions Users group, which has access to the SDMMET library. | Groups:
• HCM Solution Users
• Administrators
• Solutions Users*
Roles:
• HCM Administrator
• Data Administrator

For more information about the Form Submitter, Form Approver, and Finance Process Administrator roles, see “SAS Financial Management Groups and Roles” on page 35.

For information about roles and permissions for SAS BI Dashboard, see “Managing Security for SAS BI Dashboard” in the *SAS Intelligence Platform: Web Application Administration Guide*.


### Registering Users

**About Registering Users**

For information about registering users, see the *SAS Intelligence Platform: Security Administration Guide*.

When you define a user, be sure to include the user's e-mail address. E-mail notifications are often sent to users. For the successful processing of some functions, you must define an e-mail address for every user.

**Note:** In order for users to access a standard workspace server using credential-based host authentication, they need the local **Log on as a batch job** right on that machine. For more information, see “Windows Privileges” in the *SAS Intelligence Platform: Security Administration Guide*.

### Synchronizing Users, Groups, and Roles

**About Synchronizing Users, Groups, and Roles**

**Note:** These procedures are not required for SAS Human Capital Management.
Information for users, groups, and roles is stored in database tables that must be kept in synchronization with the metadata. As a part of best practices, it is recommended that you set up a SAS Data Integration Studio job as a scheduled process to synchronize data tables.

**Running a Batch Job**

The typical way to update user and group assignments is by using a batch job:

1. In SAS Data Integration Studio, create a batch job to update the Solutions Data Mart tables.
2. Then, schedule this job to be performed on a regular basis. Include these three jobs:
   - Load Users
   - Load Groups
   - Load User_x_Group

For more information about these jobs, see the *SAS Solutions Services: Data Administration Guide*. For information about creating batch jobs and about scheduling jobs, see the *SAS Intelligence Platform: System Administration Guide*.

**Running the Import Users and Groups Stored Process**

In some cases, changes to users, groups, and roles might need to be reflected in the database as soon as those changes are made in the metadata. In that case, you can run the jobs manually, rather than waiting for the scheduled process to run. If you need to synchronize on demand, follow these steps:

1. Log on to the portal and open Document Manager.
2. Navigate to the Products ⇒ SAS Solutions Services ⇒ 5.1 Standard Reports folder.
3. Select and run the Import Users and Groups stored process.

To run the stored process, click the action menu to the left of the stored process and select Refresh.

If you have SAS Financial Management Studio, you might need to flush the role cache. See “Clear Users in Role Cache” on page 45.

**Clear Users in Role Cache**

The Clear Users in Role Cache utility is used to clear a cache that is used only by SAS Financial Management planning security. For performance reasons, roles are cached when the Web application server is started. If you have changed any role assignments in SAS Management Console, you must flush the cache in order to use the new assignments when you assign form authors or reviewers in SAS Financial Management Studio.

To flush the cache without restarting the Web application server, add the Clear Users in Role Cache task to a My Favorites portlet. (For more information about the My Favorites portlet, see the online Help for SAS Solutions Services.) Then follow these steps:

1. In the My Favorites portlet, click Clear Users in Role Cache.
2. On the page that is displayed, click Clear Users in Role Cache.

Alternatively, you can log on to the SAS Web Administration Console, expand Application Management, and then expand Solutions Svc 5.1. In the navigation tree, click Clear Users in Role Cache. For more information, see “Administering the SAS Web Infrastructure Platform” in the *SAS Intelligence Platform: Web Application Administration Guide*. 
Chapter 4
Portal and Content Administration

Portal Administration

About Customizing the Portal ................................................................. 47
My Favorites Portlets ................................................................. 47
Alerts Portlets ........................................................................ 48
View a Report Portlet ................................................................. 48
KPI and Scorecard Portlets ......................................................... 48
Administering Content ................................................................. 49
Content and Document Manager ................................................. 49
Document Manager Folders .......................................................... 50
Security Authorization for Content ............................................. 50

Portal Administration

About Customizing the Portal

This chapter includes information about customizing the portal for the solutions, including the portlets that are provided with SAS Solutions Services. For detailed information about portal administration, consult the following references:

- the online Help for the SAS Information Delivery Portal
- the SAS Intelligence Platform: Web Application Administration Guide, available at support.sas.com/92administration

Those references explain how to administer portal content, how to create page templates, and how to administer portal authorization.

My Favorites Portlets

The My Favorites portlet has many uses. The portlet allows users to create lists of documents, files, folders, links, and tasks.

The following tasks can be added to a My Favorites portlet:

- Clear Users in Role Cache: Opens a page with a utility for flushing the role cache in SAS Financial Management
- Manage Documents: Opens the Document Manager, a SAS Solutions Services application with which users and administrators can manage content
- Manage Financial Forms: Opens the SAS Financial Management Form Manager
• **Manage Strategy Management Scorecard Projects and Templates:** Opens the project management page of SAS Strategy Management

• **New Strategy Management Scorecard Project:** Opens the New Project Wizard for SAS Strategy Management

• **Human Capital Management Home:** Opens the Home page of SAS Human Capital Management

**Alerts Portlets**

An alert is a notification of an event that the user might need to respond to. Opt-in alerts are alerts that users choose to receive by setting properties on a document or a folder in the Document Manager. For example, a user might ask to be informed of a document being added to a folder, or of a comment being added to a document. Workflow alerts are notifications of tasks that the user has to perform, such as approving a budget item. Users cannot choose not to receive these alerts.

To add an Alerts portlet to a page, select **Options ➤ Page Content** and then select **Add Portlets**. For more information about adding a portlet, see the online Help for the portal.

**View a Report Portlet**

Reports or documents that use graphs and that are viewed by the user on a regular basis are good candidates for a View a Report portlet. This portlet displays the contents of a document rather than a link to the document.

You can create a View a Report portlet from a document that you opened from Document Manager, or you can create a View a Report portlet in the portal and edit the portlet to add content. For details, see the online Help.

**KPI and Scorecard Portlets**

The following portlets are available for KPIs and scorecards:

**Table 4.1 Portlets Available with SAS Solutions Services**

<table>
<thead>
<tr>
<th>Portlet Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Performance Dashboard portlet</td>
<td>Displays KPIs and scorecard elements in graphical format. Each element is represented by a dashboard that displays, in graphical format, the data ranges that have been defined. In addition to ranges, you can display comments, history data, and element properties from a dashboard.</td>
</tr>
<tr>
<td>Performance Table portlet</td>
<td>Displays data for the selected KPI or scorecard in tabular form.</td>
</tr>
</tbody>
</table>

If you have licensed SAS Strategy Management, the Performance Dashboard and Performance Table portlets display scorecard elements as well as KPIs, and the following portlets are also available:
Table 4.2   Portlets Available with SAS Strategy Management

<table>
<thead>
<tr>
<th>Portlet Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Performance Aggregate Table</td>
<td>Displays data for the selected scorecard and all of its children.</td>
</tr>
<tr>
<td>portlet</td>
<td></td>
</tr>
<tr>
<td>Performance Association</td>
<td>Displays the hierarchical relationship between scorecard elements</td>
</tr>
<tr>
<td>portlet</td>
<td>of a single scorecard or project.</td>
</tr>
<tr>
<td>Performance Diagram</td>
<td>Displays data in the form of diagrams, to illustrate the relationships</td>
</tr>
<tr>
<td>portlet</td>
<td>between elements. The data can be based on project element types</td>
</tr>
<tr>
<td></td>
<td>or scorecard element types.</td>
</tr>
</tbody>
</table>

For information about defining these portlets, see the online Help.

Administering Content

Content and Document Manager

In terms of SAS Solutions Services, content is any document, stored process, or viewable object.

SAS Solutions Services provides a Web application, Document Manager, that displays content in a hierarchical folder structure. The following content types are supported in Document Manager:

Table 4.3   Supported Content Types

<table>
<thead>
<tr>
<th>Icon</th>
<th>Content Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Excel" /></td>
<td>ExcelReport</td>
<td>Microsoft Excel (.xls) document</td>
</tr>
<tr>
<td><img src="image" alt="Excel" /></td>
<td>ExcelReport-Dynamic</td>
<td>Microsoft Excel document that can be updated dynamically from the server (can be imported but not opened in a portlet)</td>
</tr>
<tr>
<td><img src="image" alt="Folder" /></td>
<td>Folder</td>
<td>Document Manager folder, which can contain documents and other folders</td>
</tr>
<tr>
<td><img src="image" alt="KPI" /></td>
<td>KPIProject</td>
<td>Key performance indicator (KPI) project. (For information about creating KPI projects, see the online Help.)</td>
</tr>
<tr>
<td><img src="image" alt="PDF" /></td>
<td>PDFDocument</td>
<td>PDF document</td>
</tr>
<tr>
<td><img src="image" alt="Link" /></td>
<td>SolutionsLink</td>
<td>Link to another document</td>
</tr>
<tr>
<td>Icon</td>
<td>Content Type</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><img src="image1.png" alt="Icon" /></td>
<td>SPMProject</td>
<td>Scorecard project (available with SAS Strategy Management)</td>
</tr>
<tr>
<td><img src="image2.png" alt="Icon" /></td>
<td>StoredProcess</td>
<td>Stored process</td>
</tr>
<tr>
<td><img src="image3.png" alt="Icon" /></td>
<td>WebDocument</td>
<td>HTML document or other valid MIME type, including Microsoft PowerPoint files and BMP or JPG images</td>
</tr>
<tr>
<td><img src="image4.png" alt="Icon" /></td>
<td>WordDocument</td>
<td>Microsoft Word (.doc) document</td>
</tr>
<tr>
<td><img src="image5.png" alt="Icon" /></td>
<td>WordDocument-Dynamic</td>
<td>Microsoft Word document that can be updated dynamically from the server</td>
</tr>
</tbody>
</table>

With SAS Solutions Services and the portal, system administrators can customize content for a particular site, so that each group of users can have their own view of that content. Content that is displayed within the Document Manager tree view can also be shown in portlets.

**Document Manager Folders**

Document Manager displays these top-level folders, depending on folder permissions:

- **Products**: Containing folders that hold content that is delivered with each of the products in your installation.
- **Shared Data**: Containing shared libraries, tables, cubes, and information maps.
- **My Folder**: the current user's folder for personal content. The default permissions on each user's folder allow access only to that user.

To create additional folders in Document Manager, select **New ⇒ Folder**. For more information, see the online Help.

**Security Authorization for Content**

To assign permissions to these folders or to the documents in the folders, click the action menu at the left of the folder or document name and select **Properties**. For more information, see the online Help.

The permissions that you assign are metadata permissions and can also be assigned in SAS Management Console. For further information about the processing of permissions and the way the SAS Metadata Server makes authorization decisions, see “Authorization” in the *SAS Intelligence Platform: Security Administration Guide* (available at support.sas.com/92administration).
Chapter 5

Administering the Middle Tier

Managed Server Administration ................................. 51
About the Managed Servers .................................................. 51
Additional Managed Server Modifications ......................... 52
Performance Improvement in SAS Financial Management ............... 53
Overview ........................................................................... 53
Secondary ODCS Servers for Operational Planning ..................... 53
Multiple Query Processors for Multi-User Environments ................. 57

Managed Server Administration

About the Managed Servers

This chapter contains information about administering the middle tier for the SAS Performance Management solutions. For detailed information about administering Web applications and the Web application server, see the SAS Intelligence Platform: Web Application Administration Guide, available at support.sas.com/92administration. That book also contains information about topics such as the following:

• tuning the Web application servers
• administering the SAS remote services
• installing a custom theme and setting the default theme
• modifying application configuration properties in the Configuration Manager plug-in of SAS Management Console
• administering the SAS Information Delivery Portal, SAS Web Report Studio, SAS BI Dashboard, and SAS Web OLAP Viewer
• WebDAV administration

Note: WebLogic clustering is not supported by the SAS Performance Management solutions.

For additional information, see the online Help for the Oracle WebLogic administration console or the documentation at this site: www.oracle.com/technology/documentation/bea.html.

Depending on the solutions you installed and your choices during the configuration steps, your system will have several managed servers. The following table shows the default
servers, listen ports, and a partial listing of the contents, consisting of enterprise archive (EAR) files. For complete information, see the WebLogic Console and the SAS-config-dir\lev1\web\common directory.

<table>
<thead>
<tr>
<th>Server (Default Name)</th>
<th>Partial Contents (EAR Files)</th>
<th>Default Listen Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>SASServer1</td>
<td>The Web Infrastructure Platform (WIP), the Logon Manager, the SAS Information Delivery Portal, SAS BI Dashboard</td>
<td>7001</td>
</tr>
<tr>
<td>SASServer2</td>
<td>The SAS WebDoc application, SAS Web Report Studio, SAS Web OLAP Viewer</td>
<td>7101</td>
</tr>
<tr>
<td>SASServer3</td>
<td>SAS Solutions Services and the solutions</td>
<td>7201</td>
</tr>
<tr>
<td>SASServer4</td>
<td>ODCS</td>
<td>7301</td>
</tr>
<tr>
<td>SASServer5</td>
<td>Planning Data Entry</td>
<td>7401</td>
</tr>
</tbody>
</table>

You might also install one or more secondary ODCS servers on additional managed servers. See “Secondary ODCS Servers for Operational Planning” on page 53.

The SAS Remote Services application must be started before the managed servers. If you restart SASServer1 (where sas.wip.services9.2.ear is deployed), you must restart the other managed servers as well.

**Additional Managed Server Modifications**

The following modifications might be necessary, depending on your system configuration:

- **URL Mapping**: WebLogic appears to treat domains differently if they are referenced differently (for example, [http://Dxxx/yyy](http://Dxxx/yyy) and [http://Dxxx.mycompany.com/yyy](http://Dxxx.mycompany.com/yyy)). This situation causes problems when a Web application stores information in the HttpSession context. There is a configuration parameter called `Frontend Host` that addresses this issue. According to the WebLogic documentation, this parameter should be set when the Host information coming from the URL might be inaccurate due to the presence of a firewall or proxy. If this parameter is set, the HOST header is ignored and this value is used instead.

  The `Frontend Host` parameter is part of the HTTP Protocols for a managed server. For instructions about modifying these protocols, see the WebLogic documentation.

- **If you installed SAS Human Capital Management**: To ensure best performance, restart the managed servers, as well as the SAS application servers, once a week.

- **If you installed SAS Strategy Management**: If you have a configuration with a large number of concurrent users or with a large amount of data, increase the queue size for that managed server. For instructions, see the online Help for the WebLogic administration console.
Performance Improvement in SAS Financial Management

Overview

Depending on your site's configuration and needs, the following performance improvements are possible in SAS Financial Management:

- **Secondary ODCS servers.** To make operational planning more efficient, you can add secondary ODCS servers to your configuration. When a form set is published, its forms are distributed to the available secondary servers.

  For more information, see “Secondary ODCS Servers for Operational Planning” on page 53.

- **Multiple query processors.** If you have a site in which many users are executing queries at the same time, you can add query processors to an ODCS managed server. This option does not improve the processing time for a single query. However, it enables multiple queries to execute simultaneously.

  For more information, see “Multiple Query Processors for Multi-User Environments” on page 57.

Secondary ODCS Servers for Operational Planning

How Secondary Servers Are Used

In SAS Financial Management, operational planning is supported by a configuration that includes a primary ODCS server and, optionally, one or more secondary ODCS servers. The main benefit of secondary servers is to distribute the load for the planning process.

*Note:* Secondary ODCS servers are not used by financial planning.

When a form set is published, the forms are distributed based on the ODCS servers that are available. In a configuration with two secondary ODCS servers, the forms are divided between the servers, as in this simplified diagram:
By default, the primary (master) ODCS server is not a target of the distribution, although this default can be changed. (See “Configure the Primary ODCS Server to Share the Load” on page 56.)

Install an Additional Secondary ODCS Server

During installation and configuration, secondary ODCS servers are established, based on your plan file. Typically, each ODCS EAR runs on a different host, to take full advantage of the additional memory and processing power, and each ODCS EAR references its own local SAS_FACT table. It also has an ODCSDS data source that points to the SASSDM database on the primary server.

Post-installation, you can create additional secondary ODCS servers. Follow these steps:

Note: If you are replacing an existing server, see “Replace a Secondary ODCS Server” on page 56.

1. Make sure users have logged off.

   Via the SAS Web Administration Console, you can send an e-mail message to users, notifying them of your intention to shut down the managed servers. You can also force users to log off. For more information, see “Administering the SAS Web Infrastructure Platform” in the SAS Intelligence Platform: Web Application Administration Guide.

2. Shut down the ODCS managed servers and the managed server to which you deployed SAS Financial Management (by default, SASSERVER3).

3. In the SASSDM database for the primary ODCS server, view the records in the SAS_ODCS_SERVER table. Note the host names shown in the SERVER_HOSTNAME column. If the new secondary server’s host name matches a name that is already in this column, change the host name of the new server before proceeding. (Do not delete or edit the existing database record.)

4. Install the secondary server on the target machine. Use your original plan file and follow the instructions under “Deployment of the SAS OLAP Data and Compute Server (ODCS) Secondary Mid-Tier” in the Installation Instructions for Release 5.1 of the SAS Performance Management Solutions.

This book is available on the SAS Software Depot as products \soldatier_92110_prt_xx_sp0_1\readme.pdf, or at http://

Note: SAS Financial Management Web Data Entry is also deployed to the secondary ODCS Server.

5. If you configured any JVM options for your primary ODCS server, configure the same options for your new secondary server.

6. Start the managed servers that you shut down.

Effects of Installing an Additional Secondary Server

It is important to understand the effect of installing a new secondary ODCS server. On the host machine for the secondary server, the installation script creates a database called SASSDM, containing a single SAS_FACT table. It also creates at least two data sources:

- FACTDS, pointing to the local SASSDM database
- ODCSDS, pointing to the primary ODCS server's full SASSDM database

The new server automatically registers itself with the primary ODCS server. As a result, the new server is visible to SAS Financial Management when it distributes forms during the next publish operation for a form set. Data for a form set that is already published continues to reside with its original secondary server (the work load is not rebalanced). However, the new secondary server is included in the list for future publish operations.

This diagram shows an additional secondary server, ODCS4. The forms that are part of form set A, which was published before ODCS4 was added, continue to reside on ODCS2 and ODCS3. However, form set B was published after ODCS4 was installed, and so one-third of its forms are distributed to each of the three secondary ODCS servers.

**Figure 5.2  Form Set Distribution After Addition of a Secondary ODCS Server**

If you republish a form set and select the option to delete existing data, then the republish operation can also take advantage of a new secondary server.
Configure the Primary ODCS Server to Share the Load

By default, in an installation with both primary and secondary ODCS servers, the primary ODCS server is used for financial planning, and operational planning is performed on the secondary ODCS servers.

If the site does very little financial planning, you might want the primary ODCS server to share in the load, so that it too can be a target for published forms. To configure this behavior:

1. Add the following option to the JVM options for the managed server for SAS Financial Management (by default, SASServer3):
   ```
   -Dop.forms.useMaster=true
   ```

2. Restart the managed server for SAS Financial Management (by default, SASSERVER3) and all ODCS managed servers.

Note: In a configuration with no secondary servers, all forms are published to the primary ODCS server.

Replace a Secondary ODCS Server

It is possible for a new secondary server to replace an existing secondary server and take over its current form sets. Follow these steps:

1. Make sure that users have logged off.

   Via the SAS Web Administration Console, you can send an e-mail message to users, notifying them of your intention to shut down the managed servers. You can also force users to log off. For more information, see “Administering the SAS Web Infrastructure Platform” in the SAS Intelligence Platform: Web Application Administration Guide.

2. Shut down the ODCS managed servers and the managed server to which you deployed SAS Financial Management (by default, SASSERVER3).

3. In the SASSDM database for the primary ODCS server, view the records in the SAS_ODCS_SERVER table. Note the host names shown in the SERVER_HOSTNAME column. If the new (replacement) secondary server’s host name matches a name that is already in this column, change the host name of the new server before proceeding. (Do not delete or edit the existing database record.)

4. Install the secondary server on the target machine. Use your original plan file and follow the instructions under “Deployment of the SAS OLAP Data and Compute Server (ODCS) Secondary Mid-Tier” in the Installation Instructions for Release 5.1 of the SAS Performance Management Solutions.

   This book is available on the SAS Software Depot as products \soldatatier\92110\prt\xx\sp0\1\readme.pdf, or at http://support.sas.com/documentation/installcenter/en/ikfmofigi/63034/PDF/default/install.pdf.

   Note: SAS Financial Management Web Data Entry is also deployed to the secondary ODCS Server.

5. If you configured any JVM options for your primary ODCS server, configure the same options for your new secondary server.

6. Copy the existing server's SASSDM.SAS_FACT table to the replacement server's SASSDM database:

   a. At a command prompt on the source machine, dump the SAS_FACT table:
   ```
   cmd> mysqldump sassdm sas_fact -host_name1
   -username -ppassword > sas_fact.sql
   ```
b. At a command prompt on the target machine, drop the SAS_FACT table (which should be empty) and replace it with the table from the source machine:

```bash
cmd> mysql -h host_name2 -u username -p password
mysql> drop table saasdm.sas_fact;
mysql> exit;
cmd> mysql -h host_name2 -u username -p password saasdm < sas_fact.sql
```

7. On the primary ODCS host, edit the SASSDM.SAS_ODCS_SERVER table.

In the record for the old server, replace the SERVER_HOSTNAME and SERVER_PORT values with the host name and port number of the new secondary server. Be sure to enter the full host name (including the domain). Do not use aliases, shortened names, or apparently equivalent names.

Do not change the SERVER_ID value (which is referenced by other tables) or the SERVER_TYPE value. (A SERVER_TYPE of 0 signifies a secondary server; a SERVER_TYPE of 1, a primary server.)

8. Save your changes.

9. Start the managed servers that you shut down.

*Note:* Only the primary ODCS server should have a SASSDM.SAS_ODCS_SERVER table.

Referring to Figure 5.1 on page 54, if you replaced server ODCS3 with a server named ODCS4, the result would be as follows:

**Figure 5.3  Result of Replacing a Secondary ODCS Server**

Server ODCS4 would continue to process the forms that were originally on the ODCS3 server.

---

**Multiple Query Processors for Multi-User Environments**

**Overview**

SAS Financial Management supports an optional configuration in which multiple query processors can be attached to an ODCS managed server. With this configuration, ODCS jobs are automatically routed to various machines where the ODCS query processor is running.
The benefit of this configuration is that it maximizes query processing concurrency in multi-user environments. It is most effective in situations where there are many concurrent users executing small simultaneous queries. While it does not improve the performance of individual queries, it does allow more queries to execute simultaneously and thus improves overall throughput.

**Configure ODCS Target Machines**

In a configuration with multiple query processors, each target machine must be network-accessible from the ODCS server, and each target machine must have installed the JDK. (For the correct JDK version, see the system requirements document.)

To configure a target machine:

1. Create a directory on the target machine.
2. Copy each of the JAR files from the top-level directory of the exploded ODCS application (sas.solutionsodcs5.1.ear) to the target directory.

   The exploded EAR files are in the `SAS-config-dir\Lev1\Web\Staging\exploded` directory.

3. On the target machine, run the query processor:

   ```
   java -classpath jarfiles
   -Xms800m -Xmx800m -Xss256k
   -Dodcs.dispatcher.host=host
   QueryProcessor
   ```

   - **jarfiles** is a list of the JAR files that you copied in the previous step. Separate the filenames with semicolons.

   Typically, you would create a batch file that dynamically creates the CLASSPATH from the set of JAR files, rather than listing each JAR file separately. You could also create a batch file that both copies the JAR files to a target machine and runs the query processor.

   - **-Xms** and **-Xmx** determine the initial and maximum Java heap size. For best results, these values should be the same. The optimal heap size varies from customer to customer and from site to site.

   - **-Xss** represents the thread stack size. In a 32-bit environment, the recommended value is 256K. In a 64–bit environment, 512K.

   - The **-Dodcs.dispatcher.host** option specifies the name of the machine on which the ODCS application is running.

   You can include additional options, in the form `-Doption=value`, as described in the table below.

---

### Table 5.1 Query Processor Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description and Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>odcs.dispatcher.host</code></td>
<td>The TCP/IP port on which the in-process RMI registry is hosted by ODCS and through which the query processors make the bootstrap contact. The default is <code>localhost</code>.</td>
</tr>
</tbody>
</table>
**Table 5.2 ODCS Server Options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description and Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>odcs.dispatcher.port</code></td>
<td>The TCP/IP port on which the in-process RMI registry is hosted by ODCS and through which the query processors make the bootstrap contact. The default port number is 9876.</td>
</tr>
<tr>
<td><code>odcs.dispatcher.passkey</code></td>
<td>The password key handshake between the query processor and the dispatcher. If the passkey does not match, the query processor is not allowed to connect to the dispatcher to run queries. The passkey must be specified by both the dispatcher and the query processor. For example, by passing this argument to the command lines of both the ODCS server and the query processor: <code>-Dodcs.dispatcher.passkey=mysecretpassword</code> The default is <code>passkey</code>.</td>
</tr>
<tr>
<td>Option</td>
<td>Description and Default Value</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>odc.s.dispatcher.ipfilter</td>
<td>A comma-separated list of Internet addresses of machines that are allowed to connect. If you specify such a list and a query processor tries to connect to an IP address that is not in the list, the connection is rejected. There is no default.</td>
</tr>
<tr>
<td>odc.s.dispatcher.use.internal.qp</td>
<td>If <strong>true</strong> (the default), the dispatcher uses the built-in internal query processor, in addition to any external query processors that might be available. There are benefits to running queries locally. In-process queries do not require the data to be serialized to them. Moreover, if you configure only a few external query processors, then the ODCS server might be better used to share the query load, in addition to the data and dispatch. If this argument is <strong>false</strong>, the dispatcher does not process any queries locally, so that it is always available to route queries to external query processors. This mode is useful if you have a large number of query processors.</td>
</tr>
</tbody>
</table>
Chapter 6
Viewing and Configuring the Log Files

Log File Locations and Configuration Files

The following log files are located on the middle tier, where you installed the Web application server.

<table>
<thead>
<tr>
<th>Application</th>
<th>Log File Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAS Solutions Services</td>
<td>The logs for these applications are configured using the application-log4j.xml files in the <code>&lt;SAS-config-dir&gt;\Lev1\Web\Common \LogConfig</code> directory.</td>
</tr>
<tr>
<td>SAS Financial Management</td>
<td>The default log file location is <code>&lt;SAS-config-dir&gt;\Lev1\Web \Logs</code>.</td>
</tr>
<tr>
<td>SAS Human Capital Management</td>
<td></td>
</tr>
</tbody>
</table>
For local services, SAS Strategy Management and the remote services use the logging framework from the SAS Web Infrastructure Platform. You can modify the logging configuration in the Foundation Services Manager of SAS Management Console. For more information, see “Administering SAS Web Applications” in the SAS Intelligence Platform: Web Application Administration Guide. The default log file location is SAS-config-dir\Lev1\Web\Logs.

SAS Strategy Management has two additional log files (log.txt and bmf_log.txt) that by default are written to the SAS-config-dir\Lev1\Web\Logs\SAS Strategy Management directory. The log.txt and bmf.log.txt log files are configured in the SAS-config-dir\Lev1\Web\Common\LogConfig directory. Most of the output for these loggers goes to the console. (See below.)

Oracle WebLogic

The WebLogic log files are located in subdirectories under SAS-config-dir\Lev1\Web\SASDomain\servers\server-name\logs directory, where server-name is the name of the managed server. Output to the WebLogic console is written to these log files.

### Dynamically Configuring Logging Levels

#### SAS Human Capital Management

For SAS Human Capital Management, you can dynamically change the logging levels on the Configuration tab of the Administration application. For details, see the SAS Human Capital Management: Administrator’s Guide.

#### SAS Strategy Management

For SAS Strategy Management, you can dynamically change logging levels for the Web application. The new priorities apply until the managed servers are restarted. Follow these steps:

1. Log on to SAS Strategy Management as a user in the SAS Administrators group.
3. Default logging contexts are displayed on the page.
4. Locate the priority you want to change and select the radio button in the appropriate DEBUG, INFO, WARN, ERROR, or FATAL column.
   
   Note: SAS Technical Support might provide you with a specific logging context. If so, type the context in the box at the bottom of the page and select a priority.
5. Click Set Options.

<table>
<thead>
<tr>
<th>Application</th>
<th>Log File Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAS Strategy Management Remote Services</td>
<td>For local services, SAS Strategy Management and the remote services use the logging framework from the SAS Web Infrastructure Platform. You can modify the logging configuration in the Foundation Services Manager of SAS Management Console. For more information, see “Administering SAS Web Applications” in the SAS Intelligence Platform: Web Application Administration Guide. The default log file location is SAS-config-dir\Lev1\Web\Logs. SAS Strategy Management has two additional log files (log.txt and bmf_log.txt) that by default are written to the SAS-config-dir\Lev1\Web\Logs\SAS Strategy Management directory. The log.txt and bmf.log.txt log files are configured in the SAS-config-dir\Lev1\Web\Common\LogConfig directory. Most of the output for these loggers goes to the console. (See below.)</td>
</tr>
<tr>
<td>Oracle WebLogic</td>
<td>The WebLogic log files are located in subdirectories under SAS-config-dir\Lev1\Web\SASDomain\servers\server-name\logs directory, where server-name is the name of the managed server. Output to the WebLogic console is written to these log files.</td>
</tr>
</tbody>
</table>
Configure a Log File for the SAS Financial Management Reports

On the data tier, you can configure a log file to be written when a stored process uses the Javaobj interface. Javaobj is a mechanism that is similar to Java Native Interface (JNI) for instantiating Java classes and accessing their methods and fields. This mechanism is used by the standard reports that are shipped with SAS Financial Management.

You can also use this log file to capture output from SAS Data Integration Studio jobs that invoke SAS code.

To log this output, follow these steps:

1. Create a log4j.properties file that is similar to the following:

   ```properties
   # Hierarchy: DEBUG < INFO < WARN < ERROR < FATAL
   log4j.appender.A1.layout.ConversionPattern=%d{MM-dd HH:mm:ss,SSS} [%t] [%p] %c{1} - %m%n
   
   # Modify this path as needed
   log4j.appender.A1.Append=False
   log4j.rootLogger=INFO, A1
   log4j.rootCategory=INFO, A1
   
   # for FM API loggin, add this line
   log4j.category.com.sas.solutions.finance.api=DEBUG

   # for SAS Data Integration Studio logging, add these lines
   log4j.category.com.sas.solutions=DEBUG
   log4j.category.com.sas.solutions.finance=DEBUG
   ```

2. Add the following line to the JREOPTIONS of the sasv9_usermods.cfg file:

   ```
   -Dlog4j.configuration=file:/c:/log4j.properties
   ```

   The configuration file is located in the `SAS-config-dir\Lev1\SASApp` directory. Modify the path to the log4j.properties file as needed.

---

Log Files for Client Applications

SAS Financial Management Studio and SAS Solutions Services Dimension Editor configure logging options in their .ini files.

For information about logging from SAS Data Integration Studio, see “Configure a Log File for the SAS Financial Management Reports” on page 63.
Additional Log Files

- For information about log files for other Web applications, such as SAS Web Report Studio and SAS Web OLAP Viewer, see the *SAS Intelligence Platform: Web Application Administration Guide*.

- For information about log files that are generated by the SAS servers, see “Enabling Server Logging” in the *SAS Intelligence Platform: System Administration Guide*.

Both books are available at [support.sas.com/92administration](http://support.sas.com/92administration).
Chapter 7
Administering MySQL Server

MySQL Overview

SAS Solutions Services stores common data in a MySQL database that is created during the installation process. Support for INNODB tables must be enabled within MySQL to provide transaction support, which is required by a number of SAS Solutions Services components.

MySQL Installation and Configuration (Windows)

Installing and Configuring MySQL

For installation and configuration information, see the readme.pdf file that is located in the SAS Software Depot, in the `third_party\MySQL_Database_Server\5_0_80\Windows` directory or the `third_party\MySQL_Database_Server\5_0_80\Microsoft_Windows_for_x64` directory.

Reconfiguring MySQL

The MySQL server is configured to read its configuration settings from the `MySQL-install-dir\my.ini` configuration file. If you need to adjust your MySQL configuration, you can modify these configuration settings in the MySQL Administrator, or you can edit the my.ini file directly. Before you make any changes, be sure to make a backup copy of the my.ini file. After making your changes, restart the service.

The MySQL client reads its configuration information from a copy of the my.ini file that is located in the Windows root directory (for example, `C:\WINNT\my.ini`). If you modify the `MySQL-install-dir\my.ini` file, be sure to copy your modified file to the Windows root directory.
Chapter 8
Installing the Client Applications

About the Client Applications

Client applications must be installed on Windows machines. The following client applications are available for the Performance Management solutions:

<table>
<thead>
<tr>
<th>Application</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAS Solutions Services Dimension Editor</td>
<td>The SAS Solutions Services Dimension Editor enables users to manage data dimensions.</td>
</tr>
<tr>
<td>SAS Solutions Services Add-In for Microsoft Office</td>
<td>This add-in connects an Microsoft Office application to the middle tier of SAS Solutions Services. It enables users to insert content from the solutions into a Microsoft Office document.</td>
</tr>
</tbody>
</table>
This add-in connects a desktop copy of Microsoft Excel to the middle tier and provides access to SAS Financial Management data. With this client, users can build reports that are based on data in the SAS Financial Management database, build forms for entering financial or operational data into the database, and enter financial planning data.

In addition to the client applications that are part of the solutions, users might need to install one or both of these client applications that are part of the SAS Intelligence Platform:

- SAS Management Console (for system administrators)
- SAS Data Integration Studio (for data administrators)

### Selecting a SAS Environment

*Note:* This section is an introduction to SAS environments, which are used to connect a client application to a middle tier. You will need this information when you install the client applications.

When you log on SAS Financial Management Studio or SAS Solutions Services Dimension Editor, you are asked to select a SAS environment in which the application will operate. The SAS environment file (sas-environment.xml) contains information about the resources that are necessary to run the client applications (for example, the addresses of services used by the applications).

Here is an example logon box for SAS Financial Management Studio. The **SAS environment** drop-down box contains a list of available environments. You select an environment and connect to the middle tier for that installation.

Initially, a site has a single SAS environment, representing a single installation. However, in time a site might create multiple installations. For example, a site might create separate installations for development, testing, and production. Each installation would have its own SAS environment.

The add-in clients for Microsoft Office applications use a SAS Solutions environment file (EnvironmentFactory.xml) for the same purpose.
When you install one of these client applications, you are asked for the location of the environment file. Later sections of this chapter include the following topics:

- how to specify the URL to the environment file during an installation
- how to create custom environment files for a site with multiple installations of SAS Performance Management solutions

SAS Financial Management Studio and SAS Solutions Services Dimension Editor

Overview

The Performance Management solutions include two stand-alone client applications:

- **SAS Financial Management Studio.** When SAS Financial Management is licensed, SAS Financial Management Studio enables users to build and manage the infrastructure for SAS Financial Management, including cycles, models, dimensions, and form sets.
  
  This client application is used by finance process administrators and finance adjusters.

- **SAS Solutions Services Dimension Editor.** The Dimension Editor is available as part of SAS Solutions Services. It enables users to manage data dimensions.
  
  The functionality in this application is also available in SAS Financial Management Studio.

For information about the groups and roles that are required to run these client applications, see “About SAS Financial Management Groups and Roles” on page 35.

Installation Notes

**Java Runtime Environment (JRE)**

These client applications use the default JRE on the client machine. If you want an application to use a different JRE, add a `-vm` option to the application's .INI file, with the path to the appropriate EXE or DLL file. The `-vm` option must appear before the `-vmargs` line. Here is an example:

```bash
-vm
C:\j2sdk1.5.0_12\jre\bin\client\jvm.dll
-vmargs
...
```

**SAS Environment File**

During the installation, users are asked to supply the URL for the SAS environment file (sas-environment.xml).
The default path is as follows: \texttt{http://server:7001/SASLogon/sas-environment.xml}, where \texttt{server} is the name of the middle-tier server that you want to connect to.

The SASLogon Web application is part of the sas.wip.apps9.2.ear enterprise application (EAR), which by default is deployed to the managed server on port 7001. If your site deployed this EAR to a managed server on a different port, apply the appropriate port number.

If your end users install client applications on their own machines, make them aware of the URL to the SAS environment file.

If your site has more than one SAS environment, you must supply the URL to a custom environment file instead. For more information, see “Defining Multiple SAS Environments ” on page 74.

---

### The Add-In Clients for Microsoft Office

#### Overview

The Performance Management solutions include two add-in clients for Microsoft Office applications:

- **SAS Solutions Services Add-In for Microsoft Office.** This client is part of SAS Solutions Services. It enables users to import solutions content into Microsoft Excel or Microsoft Word. All SAS Strategy Management items are available for viewing, including key performance indicator (KPI) projects and custom balanced scorecard projects.

  \textit{Note}: Stored processes cannot be run within Microsoft Excel or Microsoft Word.

  (Users can run a stored process from Document Manager, from a My Favorites portlet, or from a Collections portlet.)

- **SAS Financial Management Add-In for Microsoft Excel.** When SAS Financial Management is licensed, SAS Financial Management Add-In for Microsoft Excel is available for use by financial process administrators, form submitters or approvers, and financial report creators.
Installation Notes

Installation Sequence
If you install SAS Financial Management Add-In for Microsoft Excel, you must also install SAS Solutions Services Add-In for Microsoft Office. These clients can be installed separately or at the same time. If they are installed separately, they must be installed in this sequence:

1. SAS Solutions Services Add-In for Microsoft Office
2. SAS Financial Management Add-In for Microsoft Excel

Java Runtime Environment (JRE)
The add-ins use the JRE that is defined in the JREHOME environment variable in the sasw_config.xml file. That file is located in the Program Files\SAS directory.

SAS Solutions Environment
During the installation of SAS Solutions Services Add-In for Microsoft Office, you are asked to supply the URL for the SAS Solutions environment file (EnvironmentFactory.xml).

The default value is http://server:7201, where server is the name of the middle-tier server that you want to connect to. (The installation procedure adds the rest of the URL, including the file name.)

Note: You do not see this prompt when you install the SAS Financial Management Add-In for Microsoft Excel. The URL that you supply for the SAS Solutions Services Add-In for Microsoft Office is used by both clients.

The EnvironmentFactory.xml file is part of the sas.solutionsservices5.1.ear enterprise application, which by default is deployed to the managed server on port 7201. If your site deployed this EAR to a managed server on a different port, adjust the port number accordingly.

If your end users install client applications on their own machines, make them aware of the URL to the SAS Solutions environment file.
If your site has more than one SAS Solutions environment, you must supply the URL to a custom environment file instead. For more information, see “Defining Multiple SAS Solutions Environments” on page 75.

Complete the Installation of the SAS Solutions Services Add-In for Microsoft Office

**For Microsoft Office 2007**

For Microsoft Office 2007, complete the installation of this add-in client as follows:

1. Open Microsoft Excel.
2. Click the **Microsoft Office** button.
3. Click **Excel Options**.
4. Select the **Add-Ins** category.
5. From the **Manage** box, select **Excel Add-ins** and click **Go**.
6. In the Add-Ins Available dialog box, click **Browse**.
7. Navigate to `Microsoft-Office-install-dir\Office12\Library`.
8. Select **SAS SPM Functions.xla** and click **OK**.
9. Make sure that **SAS SPM Functions** is selected in the list and click **OK**.

**For Earlier Versions of Microsoft Office**

For earlier versions of Microsoft Office, complete the installation of this add-in client as follows:

1. Open Microsoft Excel.
2. From the **Tools** menu, select **Add-Ins**.
   
   The Add-Ins dialog box appears.
3. Click **Browse** to search for **SAS SPM Functions.xla**.
   
   This file should be located in `Microsoft-Office-install-dir\Office\Library`, `Office10\Library`, or `Office11\Library`, depending on the version of Microsoft Office that is installed.
4. Click **OK** to add it to the Add-Ins dialog box.
5. In the Add-Ins dialog box, make sure that **SAS SPM Functions** is selected.
6. Click **OK**.
7. Click **OK**.

**Verify the Installation**

To verify that the installation succeeded, open Microsoft Excel or Microsoft Word. You should see a new menu item, **SAS Solutions**, that is available to users who belong to the Solutions Users group and who have the proper roles. (See Chapter 3, “Assigning Groups and Roles,” on page 29.)
Complete the Installation of the SAS Financial Management Add-In for Microsoft Excel

Delete Existing References to the .XLA File
If you had a previous installation of the SAS Financial Management Add-In for Microsoft Excel, you might need to remove the add-in from Microsoft Excel, as follows:

1. In the Add-Ins (or Add-Ins Available) box, clear the check box for SAS Financial Management Functions.
   When you are asked if you want to delete the add-in, say yes.

2. Close Microsoft Excel and reopen it.

Microsoft Office 2007
For Microsoft Office 2007, follow these steps to complete the installation:

1. Open Microsoft Excel.
2. Click the Microsoft Office button.
3. Click Excel Options.
4. Select the Add-Ins category.
5. From the Manage box, select Excel Add-Ins and click Go.
6. In the Add-Ins Available dialog box, click Browse.
7. Navigate to Microsoft-Office-install-dir\Office12\Library.
8. Select SAS Financial Management Functions.xla and click OK.
9. Make sure that SAS Financial Management Functions is selected in the list and click OK.

Earlier Versions of Microsoft Office
For earlier versions of Microsoft Office, follow these steps to complete the installation:

1. Open Microsoft Excel.
2. Open the Add-Ins dialog box.
3. From the Tools menu, select Add-Ins.
   The Add-Ins dialog box appears.
4. Click Browse to search for SAS Financial Management Functions.xla.
   This file is located in Microsoft-Office-install-dir\Office\Library, Office10\Library, or Office11\Library, depending on the version of Microsoft Office that is installed.
5. Click OK to add this file to the Add-Ins dialog box.
6. In the Add-Ins dialog box, make sure that SAS Financial Management Functions is selected.
7. Click **OK**.
8. Click **OK**.

**Verify the Installation**

To verify that the add-in has been correctly installed, follow these steps:

1. In Microsoft Excel, click the **SAS Solutions** menu and then select **Log On**.
2. Select a SAS Solutions environment and enter a valid user name and password.
3. Click **OK**.

   The application connects to the middle-tier server.

4. From the **SAS Solutions** menu, select **Insert**.

   If the installation is successful, a pop-up menu appears showing the available options, such as **Read-only Table**.

---

**Defining Multiple SAS Environments**

The SAS environment file (sas-environment.xml) applies to the SAS Financial Management Studio and SAS Solutions Services Dimension Editor client applications. By default, this file defines a single SAS environment that represents the installation in which it resides. The Service Registry, which is specified in the file, enables desktop client applications to determine the location of required services on the middle tier and obtain a list of services available in the environment.

If you want your end users to select from multiple SAS environments, follow these steps:

1. Create a custom sas-environment.xml file, containing information about each of the available environments.
2. Deploy this file to a location where it is accessible by all possible clients. The recommended deployment location is an HTTP server.

3. If your end users perform their own client installations, make them aware of the URL to the SAS environment file, which might resemble the following: http://myhttpserver:port/sas-environment.xml.

   If the client applications are already installed, update the .INI files for SAS Financial Management Studio and SAS Solutions Services Dimension Editor to point to the correct URL.

   For more information, see “Configuring the SAS Environment File” in the SAS Intelligence Platform: Web Application Administration Guide. That book is available at support.sas.com/92administration.

### Defining Multiple SAS Solutions Environments

#### Overview of the Process

The SAS Solutions environment file (EnvironmentFactory.xml) applies to the add-in clients for Microsoft Office applications. If you have multiple SAS Solutions environments (such as development, test, and production) and want your users to be able to select from these environments when they log in to the middle tier, follow these steps:

1. Customize one of the EnvironmentFactory.xml files to include information for each SAS Solutions environment, and deploy it to an HTTP server, in the same way you deployed the sas-environment.xml file.

   For instructions, see “Defining Multiple SAS Environments” on page 74.

2. If your end users perform their own client installations, make them aware of the URL to the custom EnvironmentFactory.xml file. The URL might resemble the following: http://myhttpserver:port.

   If the client applications are already installed, update the .INI file for SAS Solutions Services Add-In for Microsoft Office so that it contains the correct URL. (This file is also used by SAS Financial Management Add-In for Microsoft Excel.)

   Note: The EnvironmentFactory.xml file should be synchronized with the sas-environment.xml file. That is, if you define multiple SAS environments for SAS Financial Management Studio, you should define comparable SAS Solutions environments for the add-ins.

#### Modifying the EnvironmentFactory.xml File

By default, the EnvironmentFactory.xml file defines a single SAS Solutions environment that represents the installation in which it resides. The file has the following structure:

```xml
<environments>
  <environment name="environment-name">
    <object>
      ...
    </object>
    ...
    [additional object definitions]
  </environment>
</environments>
```
The environment-name is an identifier that appears in the selection list when a user logs on to the middle tier from SAS Solutions Services Add-In for Microsoft Office or SAS Financial Management Add-In for Microsoft Excel.

To modify this file, follow steps similar to the following:

1. Copy the EnvironmentFactory.xml file from one of the installations. This file is located in the `SAS-config-dir\Lev1\Web\Applications\SASSolutionsServices5.1` directory.

2. Open the copied file for editing.

3. Copy the default environment definition (from `<environment name="default">` through `</environment>`) and paste it directly after the `</environment>` tag of the first entry.

4. Give this second environment definition a new environment-name, such as `test`. Names must be valid as XML attributes.

5. Modify the server name (and port number, if necessary) of each entry for the `test` environment definition.

In a WebLogic configuration, the result might resemble the following:

```xml
<environments>
  <environment name="test">
    <object>
      <name>default</name>
      <java.naming.factory.initial>weblogic.jndi.WLInitialContextFactory</java.naming.factory.initial>
      <java.naming.provider.url>t3://server1:7201</java.naming.provider.url>
    </object>
    <object>
      <name>login</name>
      <webservice.url>http://server1:7201/SASSolutionsServices/services/AuthenticationService</webservice.url>
    </object>
    ...
  </environment>
  <environment name="production">
    <object>
      <name>default</name>
      <java.naming.factory.initial>weblogic.jndi.WLInitialContextFactory</java.naming.factory.initial>
      <java.naming.provider.url>t3://server2:7201</java.naming.provider.url>
    </object>
    ...
  </environment>
</environments>
```
6. Follow steps 3–5 (with a different `environment-name` and different server names) to create an environment definition for the production environment.

7. Save your changes.

Deploy the file to the same HTTP server where you deployed the SAS environment file. It is not necessary to restart the managed servers or redeploy the SAS Solutions Services application.

The next time users try to log on to the middle tier from one of the Microsoft Office Add-Ins, the new SAS Solutions environment choices will be available.

---

**Uninstalling the Client Applications**

If you are upgrading from an older installation, you must first uninstall any existing client applications, using the Add or Remove Programs utility of Microsoft Windows. Follow these steps:

1. Close any open Microsoft Office applications.

2. Uninstall the add-ins using this sequence:
   a. SAS Financial Management Add-In for Microsoft Excel
   b. SAS Solutions Services Add-In for Microsoft Office
   The SAS Financial Management Studio and SAS Solutions Services Dimension Editor can be uninstalled at any point in the sequence.

3. Restart your machine.
Appendix 1
Default Port Usage

The following table shows the default port numbers for SAS servers and spawners that are installed in a Level SAS environment that includes the SAS Performance Management solutions. The table also includes default third-party ports.

The SAS Deployment Wizard allows different port numbers to be specified. Therefore, your site might use different port numbers than the ones that are shown here. For a complete list, see the pre-install checklist for your site.

**Table A1.1 Default Port Numbers and Descriptions**

<table>
<thead>
<tr>
<th>Port Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>25</td>
<td>SMTP mail: Port used by mailhost or Simple Mail Transfer Protocol (SMTP). Used to send administrative e-mail notices and end-user alert notifications.</td>
</tr>
<tr>
<td>80</td>
<td>HTTP Server: Handles proxy requests to application server. Also used for static assets such as themes, style sheets, and images.</td>
</tr>
<tr>
<td>2171</td>
<td>SAS Table Server port.</td>
</tr>
<tr>
<td>3306</td>
<td>Database server port. All JDBC access from the managed servers goes through this port to the MySQL server. SAS/ACCESS to MySQL also uses this port.</td>
</tr>
<tr>
<td>5091</td>
<td>SAS Remote Services application port. All client access to remote Foundation Services is directed through this port. In solutions deployments, only middle-tier clients communicate via RMI. Therefore, it is not necessary to open this port to external access (that is, to other clients on the network) in a firewall-protected environment.</td>
</tr>
<tr>
<td>5451</td>
<td>SAS OLAP Server port.</td>
</tr>
<tr>
<td>5556</td>
<td>(Oracle WebLogic Server) NodeManager port.</td>
</tr>
<tr>
<td>6051</td>
<td>Event Broker service: listen port for administrator.</td>
</tr>
<tr>
<td>7001, 7101, 7201, 7301, 7401</td>
<td>(Oracle WebLogic Server) Nonsecure listen ports for managed servers. Additional managed server port numbers are incremented by 100. Used by Web applications and by many of the client applications, such as SAS Financial Management Studio.</td>
</tr>
<tr>
<td>7002, 7102, 7202, 7302, 7402</td>
<td>(Oracle WebLogic Server) Secure listen ports for managed servers. Additional managed server port numbers are incremented by 100.</td>
</tr>
<tr>
<td>Port Number</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>7501</td>
<td>(Oracle WebLogic Server) Listen port for the administration server.</td>
</tr>
<tr>
<td>7551</td>
<td>SAS/CONNECT Server port.</td>
</tr>
<tr>
<td>8111</td>
<td>Event Broker service: used by SAS Solutions Services for HTTP transports into the Foundation Services Event Broker. Events fired by SAS code into the middle tier are communicated via this port.</td>
</tr>
<tr>
<td>8451</td>
<td>Operating System Services scheduler port.</td>
</tr>
<tr>
<td>8551</td>
<td>SAS/SHARE Server.</td>
</tr>
<tr>
<td>8561</td>
<td>SAS Metadata Server: Default port for metadata access. This is also the default multicast UDP port number.</td>
</tr>
<tr>
<td>8571</td>
<td>SAS Object Spawner Load Balancing: Load-balancing requests from SAS Object Spawner go through this port.</td>
</tr>
<tr>
<td>8581</td>
<td>SAS object spawner: operator port.</td>
</tr>
<tr>
<td>8591</td>
<td>SAS Workspace Server port. Might also be shared by Metadata utilities SAS Workspace Server port.</td>
</tr>
<tr>
<td>8611, 8621, 8631</td>
<td>SAS Stored Process Server: load balancing connections 1, 2, and 3 (MultiBridge).</td>
</tr>
<tr>
<td>8701</td>
<td>SAS Pooled Workspace Server port.</td>
</tr>
<tr>
<td>8801, 8811, 8821</td>
<td>SAS object spawner: pooled workspace server port banks 1, 2, and 3.</td>
</tr>
<tr>
<td>9000</td>
<td>Port used to register SAS BI portlets with the portal.</td>
</tr>
<tr>
<td>10021</td>
<td>SAS Deployment Tester server port.</td>
</tr>
</tbody>
</table>

When you set up a multiple-level SAS environment (for example, an environment that consists of separate levels for development, test, and production), the SAS Deployment Wizard increments each port number by 1 for each level. For example, the default Level 1 port number for the SAS Metadata Server is 8561. A Level 2 environment would use port 8562.

For additional information, see the “Default SAS Ports” appendix of the SAS Intelligence Platform: System Administration Guide.
Index

A
administrators
  setting e-mail addresses 6
alerts
  Alerts portlets 48
  multiple 48
  types of 48
Alerts portlets 48
authentication
  user security and 29

B
batch job rights 26

C
Clear Users in Role Cache 45
client applications 67
  See also SAS Financial Management Add-In for Microsoft Excel
  See also SAS Financial Management Studio
  See also SAS Solutions Services Add-In for Microsoft Office
  See also SAS Solutions Services Dimension Editor
SAS Financial Management Studio 69
uninstalling 77
configuration
  Web applications 52
configuration directory 3
content 49
  default folders 50
  types 49
content types 49
conventions 3
CTA behavior for intercompany transactions 12

diagnoses configuration file
  modifying (SAS Human Capital Management) 8
diagrams 48
dimension management 1
document management 1
Document Manager 49
  creating folders 50
documentation conventions 3
e-mail addresses
  for administrators 6
  for notifications 44
EnvironmentFactory.xml
  See SAS Solutions environments
favorites 47
folders
  creating with Document Manager 50
  default folders 50
  Products folder 50
  Shared Data folder 50
  Users folder 50
folders and files
  securing, in operating system 14
group and role assignments
  examples 34, 37, 42
groups
  SAS Financial Management 35
  SAS Human Capital Management 40
  SAS Solutions Services 31
  SAS Strategy Management 32
synchronizing users, groups, and roles 45

I
Import Users and Groups 44

K
key performance indicator (KPI) 1

L
localizations
  for SAS Human Capital Management 10
  for SAS Strategy Management 11
log files
  configuring 61
  configuring, dynamically (for SAS Human Capital Management) 62
  configuring, dynamically (for SAS Strategy Management) 62
  for client applications 63
  for SAS Data Integration Studio jobs 63
  for SAS Financial Management reports 63
  location 61
  on middle tier 61
log on as a batch job right 26

M
managed servers
  See WebLogic managed servers
metadata identities 29
  creating 26
metric definition file
  modifying, for SAS BI Dashboard 11
Microsoft Office integration 1
middle tier
  log files on 61
multiple query processors 57
My Favorites portlets 47
MySQL 65
  installation directory 3
MySQL server
  installing and configuring 65
  securing access 15
  security 15
MySQL Server
  overview 65
  reconfiguring 65

O
ODCS servers
  secondary 53
OLAP schema
  permissions, for SAS Human Capital Management 7

P
Performance Aggregate Table portlet 48
Performance Association portlet 48
Performance Diagram portlet 48
performance improvement
  SAS Financial Management 53
  SAS Human Capital Management 52
  SAS Strategy Management 52
permissions
  role permissions 30
Planning Workflow alerts 48
portal administration
  customizing the portal 47
  portal customization 47
  Alerts portlets 48
  My Favorites portlets 47
  viewing reports 48
portlets
  Alerts 48
  My Favorites 47
  SAS Strategy Management 48
  View a Report 48
ports
  default usage 79
post-configuration steps
  loading production data 27
post-configuration tasks
  configuring Quick Help 13
  creating users and groups 26
  installing client applications 27
  overview 6
  SAS Financial Management 12
  SAS Human Capital Management 7
  SAS Strategy Management 11
production data, loading 27
Products folder 50

Q
query processors, multiple 57
Quick Help
  configuring 13

R
registering users 44
reports
  viewing 48
role cache
flushing (SAS Financial Management) 45
role-based user interface 1
roles 30
enforcing permissions 30
SAS Financial Management 35
SAS Human Capital Management 41
SAS Solutions Services 31
SAS Strategy Management 33
synchronizing users, groups, and roles 45

S
sample data
SAS Financial Management 17
SAS Human Capital Management 22
verifying with 17, 22
SAS_USER_EMPLOYEE table 40
SAS BI Dashboard
metric definition file 11
metric definition file (SAS Human Capital Management) 8
SAS Data Integration Studio 67
configuring a user 16
SAS environment
overview 68
selecting 68
SAS environment file
default 69
specifying during installation 69
SAS environments
multiple 74
SAS Financial Management 1
groups 35
multiple query processors 57
performance improvement 53
post-configuration tasks 12
roles 35
sample data 17
SAS environment file 69
primary ODCS servers 53
typical users 37
verifying the installation 17
SAS Financial Management Add-In for
Microsoft Office 67, 70
completing the installation 72
installation sequence 71
JRE 71
SAS Solutions environments 71
verifying the installation 72
SAS Solutions Services Dimension Editor 67
JRE 69
overview 69
SAS environment file 69
SAS Strategy Management 1
groups 32
performance improvement 52
post-configuration tasks 11
roles 33
sample project 26
typical users 34
verifying the installation 26
SAS Strategy Management portlets 48
SAS Web Report Studio
modifying properties 7
sas-environment.xml
See SAS environments
SAS Human Capital Management 1
date format 10
groups 40
localizations 10
non-English languages 9
OLAP schema permissions 7
performance improvement 52
roles 41
sample data 22
typical users 42
user qualifications 40
verifying the installation 22
SAS Management Console 67
SAS Notes 27
SAS Solutions environment 68
SAS Solutions environments 71, 75
multiple 75
SAS Solutions Services 1
groups 31
roles 31
user identities 30
SAS Solutions Services Add-In for
Microsoft Office 67, 70
completing the installation 72
installation sequence 71
JRE 71
SAS Solutions environments 71
verifying the installation 72
SAS Solutions Services Dimension Editor 67
JRE 69
overview 69
SAS environment file 69
SAS Strategy Management 1
groups 32
performance improvement 52
post-configuration tasks 11
roles 33
sample project 26
typical users 34
verifying the installation 26
SAS Strategy Management portlets 48
SAS Web Report Studio
modifying properties 7
sas-environment.xml
See SAS environments
SASMEXPSC macro
security
authentication and user security 29
MySQL 15
MySQL server 15
operating system 14
Shared Data folder 50
modifying, for SAS Strategy Management 11
synchronizing users, groups, and roles 45

U
uninstalling client applications 77
User Opt-in alerts 48
user security
  authentication and 29
users
  registering 44
  synchronizing users, groups, and roles 45
users, registering 44
users, synchronizing 44

V
verification 17, 22
View a Report portlet 48
  creating 48

W
Web applications
  configuring 52
WebLogic managed servers 51
Windows
  log on as a batch job right 26

Users folder 50
Your Turn

We welcome your feedback.

• If you have comments about this book, please send them to yourturn@sas.com.
  Include the full title and page numbers (if applicable).

• If you have comments about the software, please send them to suggest@sas.com.
Whether you are new to the work force or an experienced professional, you need to distinguish yourself in this rapidly changing and competitive job market. SAS® Publishing provides you with a wide range of resources to help you set yourself apart. Visit us online at support.sas.com/bookstore.

**SAS® Press**

Need to learn the basics? Struggling with a programming problem? You’ll find the expert answers that you need in example-rich books from SAS Press. Written by experienced SAS professionals from around the world, SAS Press books deliver real-world insights on a broad range of topics for all skill levels.

**SAS® Documentation**

To successfully implement applications using SAS software, companies in every industry and on every continent all turn to the one source for accurate, timely, and reliable information: SAS documentation. We currently produce the following types of reference documentation to improve your work experience:

- Online help that is built into the software.
- Tutorials that are integrated into the product.
- Reference documentation delivered in HTML and PDF – free on the Web.
- Hard-copy books.

**SAS® Publishing News**

Subscribe to SAS Publishing News to receive up-to-date information about all new SAS titles, author podcasts, and new Web site features via e-mail. Complete instructions on how to subscribe, as well as access to past issues, are available at our Web site.